
(Windows)
OPENTIME GROUP SCHEDULER AND PERSONAL AGENDA
CORPORATE TIME GROUP SCHEDULER AND PERSONAL AGENDA

Version 3.4
(First Printing)
June 1997

Copyright

Corporate Software & Technologies Int. (CS&T Int.), 1997. All rights reserved. No part of this publication may be reproduced, transmitted, transcribed, stored in a retrieval system, or translated into any language in any form by any means without the express written permission of CS&T Int.

Software License Notice

Your license agreement with CS&T Int., which is included with the product, specifies the permitted and prohibited use of the product. Any unauthorized duplication or use of OpenTime or CorporateTime, in whole or in part, in print, or any other storage and retrieval system, is forbidden.

Trademarks

CS&T, OpenTime, and CorporateTime are registered trademarks of Corporate Software & Technologies Int. Hewlett Packard and HP are registered trademarks of Hewlett Packard Company. Netscape is a registered trademark of Netscape Communications Corporation in the United States and other countries. Windows and Windows NT are registered trademarks of Microsoft Corporation in the United States and other countries.

Notice

CS&T Int. makes no expressed or implied warranty with regard to the programs and materials offered or their merchantability or their fitness for any particular purpose. The program, materials, and documentation are made available solely on an "as is" basis, and the entire risk as to their quality, reliability, and performance is with the user. Should the program material or documentation prove defective, the user (not CS&T Int., or any other party) shall bear the entire cost of all necessary correction and all incidental or consequential damages. CS&T Int. shall not be liable for any incidental or consequential damages in connection with or arising out of the furnishing, use, or performance of the supplied material.

Corporate Software & Technologies Int.
3333 Graham Boulevard, 5th Floor
Montreal, QC CANADA H3R 3L5
tel: (514) 733-8500
fax: (514) 733-8878
e-mail: info@cst.ca
BEFORE YOU BEGIN

This Agenda has been designed with a detailed On-line Help system. If at any time you need help using your Agenda, press F1 to view a help text specific to the screen you are viewing. Most dialog boxes also contain a HELP button, which opens a context-specific help text with instructions explaining how to use the dialog box.
This Agenda will look familiar to anyone who has used a paper agenda. To enter an appointment, simply highlight the time of the meeting, type in a title, and press Enter. You can make it a recurring meeting, write in details about it, set reminders for it, and invite other people or resources to it. Your Agenda can even suggest dates and times when all the people and resources you have invited are available.

But it is more than just a personal calendar: it is an enterprise-wide organizer. By creating a Group Agenda displaying the Daily Agenda Views of several users and resources (such as conference rooms or overhead projectors) side by side, you can see when everyone is free and invite them all to the meeting. You can also notify the invitees of the event by e-mail. For those who need to schedule events with people in other time zones, all Agendas are converted to the local time of the user, making it easy to arrange convenient meeting times around the world.

You can view your Agenda by day, by week, or by month. Should you want to reschedule an Entry, you can drag-and-drop it to a new time, even to a new day in the week view, or a different week in the month view. All of the people and resources invited will be notified of the change. If someone has invited you to a meeting, you can see details about it by double-clicking it. From there you can respond that you will attend, not attend, have not yet decided, or would prefer another time. You can also check who has responded to your invitations by double-clicking the meeting in question.

The In-tray folders contain Entries you have received, Entries you have sent out, Entries you have accepted, and Entries you have refused. By double-clicking any Entry, you can see details about it. You can drag-and-drop Entries from one folder to another to quickly respond to invitations. This makes it simple to respond to new invitations, change your mind about attending a meeting, or track attendance of others.

Access Rights allow you to control who can access your Agenda, and how much of it they can access. You can assign full Viewing Rights, allowing another user to see details of your Entries. You can assign “Busy time”, which allows others to see only that you are occupied. Viewing Rights can also be assigned according to the access level of the Entry. For example, you may not want to give access to confidential entries, but to give full access to public entries. You can also assign no Viewing Rights. You can tailor the Agenda to suit your needs and preferences. Designate Rights allow you to authorize selected individuals who can work on your behalf within your Agenda. A designate can access your Agenda just as you would and create, edit, and respond to events for you. You can give full or partial designate rights to one or several people.

You can choose to print your own customized pages, or pages for a number of commercial paper planner formats. You can print your day, week, or month agenda, a task list, your In-tray, and other combinations.

If you require mobility, you can export your calendar to a palmtop or laptop. You can also export the calendars of those people and resources you deal with most often. While off-line, you can schedule meetings, group meetings, and respond to invitations as you would normally.
## CONTENTS

### INTRODUCTION
- BEFORE YOU BEGIN.................................................................III
- ICON GLOSSARY........................................................................ XI
- GLOSSARY.................................................................................. XXI
- KEY CONVENTIONS...................................................................... XXV

### GETTING STARTED
- SIGNING IN.................................................................................. 1
  - ON-LINE.................................................................................. 1
  - OFF-LINE............................................................................... 1
  - AS A RESOURCE................................................................. 2
- CHANGING YOUR PASSWORD....................................................... 2

### THE AGENDA PAGES
- OPENING AGENDAS................................................................. 3
  - AN AGENDA........................................................................ 3
  - A GROUP AGENDA............................................................... 4
  - A GROUP AGENDA AS DESIGNATE...................................... 4
- THE DAILY AGENDA PAGE......................................................... 6
  - THE DAY VIEW.................................................................... 7
  - THE TASK VIEW.................................................................. 9
  - THE NOTES VIEW............................................................... 10
  - THE DATE CONTROL BAR (DAILY PAGE).............................. 11
- THE WEEKLY AGENDA PAGE...................................................... 12
  - THE WEEK VIEW.................................................................. 13
  - THE NOTES VIEW............................................................... 14
  - THE DATE CONTROL BAR (WEEKLY PAGE)............................ 14
- THE MONTHLY AGENDA PAGE................................................... 16
  - THE MONTH VIEW................................................................ 16
  - THE DATE CONTROL BAR (MONTHLY PAGE)......................... 18
  - THE GROUP AGENDA............................................................ 19

### THE IN-TRAY
- GENERAL..................................................................................... 21
  - REPLYING TO AN INVITATION............................................ 23
- THE IN-TRAY FOLDERS............................................................. 23
  - NEW ENTRIES....................................................................... 23
  - ENTRIES YOU’VE ACCEPTED.............................................. 24
  - ENTRIES YOU’VE SENT OUT............................................... 24
  - ENTRIES YOU’VE REFUSED.................................................. 24

### THE TASK DISPLAY
- OPENING A TASK DISPLAY...................................................... 25
YOUR TASKS.................................................................25
MODIFY OTHER’S TASKS.................................................26
VIEW OTHER’S TASKS.......................................................26
WORKING IN THE TASK DISPLAY.................................26

DESIGNATES
GRANTING DESIGNATE RIGHTS.........................................29
WORKING AS A DESIGNATE.................................................29
IN AN AGENDA.................................................................29
IN A GROUP AGENDA.........................................................30
IN THE TASK DISPLAY.........................................................30
AS A RESOURCE DESIGNATE.............................................30

ENTRIES
AGENDA ENTRIES..............................................................33
CREATING AGENDA ENTRIES..............................................33
SCHEDULING CONFLICTS..................................................35
SUGGEST ANOTHER DATE OR TIME...................................36
EDITING AGENDA ENTRIES...............................................36
VIEWING AGENDA ENTRIES...............................................37
DAY EVENTS......................................................................38
CREATING DAY EVENTS.....................................................38
EDITING DAY EVENTS.........................................................39
VIEWING DAY EVENTS.........................................................39
DAILY NOTES....................................................................40
CREATING NOTES...............................................................40
EDITING NOTES.................................................................40
VIEWING NOTES...............................................................40
EDITING MULTIPLE ENTRIES..............................................41
RECURRING AGENDA ENTRIES...........................................41
RECURRING DAY EVENTS AND NOTES.................................41
TASKS.............................................................................42
CREATING TASKS...............................................................42
EDITING TASKS.................................................................43
VIEWING TASKS.................................................................43
HOLIDAYS.........................................................................44
TIME SELECTION.................................................................44
THE CALENDAR.................................................................45

REMINDERS
UPCOMING NOTES..........................................................47
POP-UP WINDOWS.............................................................47

LISTS AND GROUPS
CREATING LISTS...............................................................49
ADDING PEOPLE...............................................................49
ADDING RESOURCES........................................................50
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adding Groups</td>
<td>50</td>
</tr>
<tr>
<td>Managing Groups</td>
<td>51</td>
</tr>
<tr>
<td>Creating Groups</td>
<td>52</td>
</tr>
<tr>
<td>Modifying an Existing Group</td>
<td>52</td>
</tr>
<tr>
<td>Deleting a Group</td>
<td>53</td>
</tr>
<tr>
<td>Searching</td>
<td></td>
</tr>
<tr>
<td>Single User Selection Searches</td>
<td>55</td>
</tr>
<tr>
<td>People</td>
<td>55</td>
</tr>
<tr>
<td>Resources</td>
<td>56</td>
</tr>
<tr>
<td>Groups</td>
<td>56</td>
</tr>
<tr>
<td>Multiple User Selection Searches</td>
<td>57</td>
</tr>
<tr>
<td>Directory Searches</td>
<td>58</td>
</tr>
<tr>
<td>Where Is</td>
<td>58</td>
</tr>
<tr>
<td>Access Rights</td>
<td></td>
</tr>
<tr>
<td>General</td>
<td>59</td>
</tr>
<tr>
<td>Designate Rights</td>
<td>60</td>
</tr>
<tr>
<td>Viewing Rights</td>
<td>61</td>
</tr>
<tr>
<td>Task Viewing Rights</td>
<td>62</td>
</tr>
<tr>
<td>Scheduling Rights</td>
<td>63</td>
</tr>
<tr>
<td>Setting Preferences</td>
<td></td>
</tr>
<tr>
<td>Scheduling Preferences</td>
<td>65</td>
</tr>
<tr>
<td>Color Coding</td>
<td>65</td>
</tr>
<tr>
<td>General Preferences</td>
<td>66</td>
</tr>
<tr>
<td>Name Formats</td>
<td>66</td>
</tr>
<tr>
<td>Date and Time Formats</td>
<td>67</td>
</tr>
<tr>
<td>Time Zones</td>
<td>67</td>
</tr>
<tr>
<td>Off-line Preferences</td>
<td>68</td>
</tr>
<tr>
<td>Off-line Location</td>
<td>68</td>
</tr>
<tr>
<td>Off-line Entry Downloading</td>
<td>69</td>
</tr>
<tr>
<td>Off-line People/Resources Downloading</td>
<td>69</td>
</tr>
<tr>
<td>Off-line Group Downloading</td>
<td>69</td>
</tr>
<tr>
<td>Off-line Reconciliation Preferences</td>
<td>70</td>
</tr>
<tr>
<td>Agenda Preferences</td>
<td>71</td>
</tr>
<tr>
<td>Display</td>
<td>71</td>
</tr>
<tr>
<td>Notification</td>
<td>72</td>
</tr>
<tr>
<td>In-tray Preferences</td>
<td>72</td>
</tr>
<tr>
<td>New Entries</td>
<td>72</td>
</tr>
<tr>
<td>Accepted Entries</td>
<td>73</td>
</tr>
<tr>
<td>Entries Sent</td>
<td>73</td>
</tr>
<tr>
<td>Refused Entries</td>
<td>73</td>
</tr>
<tr>
<td>Entry Defaults</td>
<td>74</td>
</tr>
<tr>
<td>Agenda Entry Defaults</td>
<td>74</td>
</tr>
<tr>
<td>Task Defaults</td>
<td>74</td>
</tr>
</tbody>
</table>
ICON GLOSSARY

CS&T ICONS

CS&T ICON
This icon will appear on-screen when you minimize your Agenda window.

ALERT ICON
If you have minimized your Agenda window, the CS&T icon becomes this Alert icon when new Entries appear in your In-tray.

THE DIALOG BOXES

THE GREEN CHECKMARK ICON
This icon can indicate many different things, depending on the context. In the dialog boxes it signifies one of the following:

- the user has accepted the Entry (when an Entry’s participants are displayed on a People/Resources list);
- there are no conflicting Agenda Entries (when you check conflicts for an Agenda Entry);
- you have accepted a recurring Entry for this recurrence (when you’re viewing a recurring Entry).

(See also: THE IN-TRAY, THE MONTHLY PAGE.)

THE RED “X” ICON
This icon can indicate many different things, depending on the context. In the dialog boxes it signifies one of the following:

- the user has refused the Entry (when an Entry’s participants are displayed on a People/Resources list);
- there are conflicting Agenda Entries (when you check conflicts for an Agenda Entry);
- you have refused a recurring Entry for this recurrence (when you’re viewing a recurring Entry).

(See also: THE IN-TRAY, THE MONTHLY PAGE.)

THE ATTENDING BUT WOULD LIKE TO RESCHEDULE ICON
This icon appears in several places. When you see it next to a user name, it indicates the user will attend the event, but would prefer it were scheduled for another time. When viewing a recurring Entry, the icon can be found next to the dates of recurrences for the Entry. Here it indicates that you have answered that you will attend that recurrence, but would prefer it were scheduled for another time.

(See also: THE IN-TRAY.)
THE NOT ATTENDING BUT WOULD LIKE TO RESCHEDULE ICON

This icon appears in several places. When you see it next to a user name, it indicates the user will not attend the event, but would attend if it were scheduled for another time. When viewing a recurring Entry, the icon can be found next to the dates of recurrences for the Entry. Here it indicates you will not attend that recurrence, but would attend if it were scheduled for another time.

(See also: THE IN-TRAY.)

THE MAIL MESSAGE BUTTON

Clicking this button opens the Mail Message dialog box, which allows you to send an e-mail message to other users.

THE CALENDAR BUTTON

The Calendar button appears next to date boxes in many dialog boxes within the Agenda. Clicking it opens this box:

When you call up this calendar from a dialog box, it sets the date in the corresponding date box.

(See also: THE DATE CONTROL BARS.)

THE CLOCK BUTTON

The Clock button appears next to time boxes in many dialog boxes within the Agenda. Clicking it calls up this box:

It allows you to set a time in the corresponding time box.

THE ABOUT A DAY EVENT ICON

This icon appears in the Pop-up Reminder dialog box, the vCalendar Entries Found dialog box, and in the Reconciliation dialog boxes; it indicates that the dialog box refers to a Day Event.

THE ABOUT AN AGENDA ENTRY ICON

This icon appears in the Pop-up Reminder dialog box, the vCalendar Entries Found dialog box, and in the Reconciliation dialog boxes; it indicates that the dialog box refers to an Agenda Entry.

THE ABOUT A TASK ICON

This icon appears in the Pop-up Reminder dialog box, the vCalendar Entries Found dialog box, and in the Reconciliation dialog boxes; it indicates that the dialog box refers to a Task.

THE ABOUT A NOTE ICON

This icon appears in the Pop-up Reminder dialog box, the vCalendar Entries Found dialog box, and in the Reconciliation dialog boxes; it indicates that the dialog box refers to a Daily Note.
ADDING NAMES

THE “X” BUTTON

This button appears whenever you are choosing to accept or refuse something that has been entered in an edit box. Clicking this button will erase the information—it will not be entered. For example, when you are adding a user to a list of people and resources, you must enter the name in the edit box. If you decide you do not want to add the name to the list you are creating, click this button.

THE CHECKMARK BUTTON

This button appears whenever you are choosing to accept or refuse something that has been entered in an edit box. By clicking this button you accept the information. For example, when you are adding a user to a list of people and resources, you must enter the name in the edit box. To add the name to the list you are creating, you must click this button.

THE SEARCH BUTTON

Clicking this button opens the Directory Search dialog box. It lets you search the directory for the names of other people, resources, or groups within the network.

THE RED QUESTION MARK BUTTON

Clicking this button opens the Help Topic about adding names. This button always appears with the edit box used for adding people or resources to a list.

THE GROUP BUTTON

When the Group button appears next to an Add edit box within a dialog box, clicking it opens the Group Selection dialog box. Using this dialog box you can add an entire group of people and resources to a list.

(See also: THE TOOLBAR)

THE DAILY & WEEKLY PAGES

THE ROUND CHECKMARK

This icon may appear on the upper right-hand corner of Agenda Entries in your Daily, Weekly, and Group Agenda pages. It indicates you plan to attend the Entry.

THE ROUND “X”

This icon may appear on the upper right-hand corner of Agenda Entries in your Daily, Weekly, and Group Agenda pages. It indicates you do not plan to attend the Entry.

THE ROUND QUESTION MARK

This icon may appear on the upper right-hand corner of Agenda Entries in your Daily, Weekly, and Group Agenda pages. It indicates you have not yet responded to the Entry.

THE PENCIL ICON

This icon may appear in Agenda Entries and Tasks on your Daily, Weekly, and Group Agenda pages, as well as in your Task Display. It indicates there is a Description included with the Agenda Entry, or Comments included with the Task. To view the Description or the Comments, open the Entry and select the Details tab.

THE PAPER CLIP ICON

This icon may appear in Agenda Entries and Tasks on your Daily, Weekly, and Group Agenda pages, as well as in your Task Display. It indicates there is a file attached to the Agenda Entry or the Task. To open the Attachment, go to the Details tab of the Entry.
THE GROUP ICON

This icon may appear on the upper left-hand corner of Agenda Entries in your Daily, Weekly, and Group Agenda pages. It indicates there are other users invited to the Entry.

THE BELL ICON

This icon may appear in Agenda Entries and Tasks on your Daily, Weekly, and Group Agenda pages, as well as in your Task Display. It indicates you have set a Reminder for the Entry.

THE MONTHLY PAGE

THE GRID BUTTON

This button appears on the Date Control Bar of your Monthly Agenda page. Clicking this button returns the calendar grid to its default setting. (This is useful if you have moved around several of the splitters—it regenerates an evenly sized calendar grid.)

THE MORE ICON

This icon indicates there are more Entries contained in the grid square than what is visible. Scroll down through the Entries to view those not displayed.

THE DAY EVENT ICON

This icon indicates the Entry next to it is a Day Event. It can appear in the Notes View of the Daily and Weekly Agenda pages, the Month View of the Monthly Agenda page, and in the In-tray.

THE NOTE ICON

This icon indicates the Entry is a Note. It can appear in the Notes View of the Daily and Weekly Agenda pages, the Month View of the Monthly Agenda page, and in the In-tray.

THE HOLIDAY ICON

This icon indicates the Entry is a Holiday. It can appear in the Notes View of the Daily and Weekly Agenda pages, the Month View of the Monthly Agenda page, and in the In-tray. It can also appear in the Pop-up Reminder dialog box when the Reminder is for a Holiday.

THE RED “X” ICON

This icon indicates many different things, depending on the context. In the Month View it indicates you have refused the Agenda Entry next to it. (See also: THE DIALOG BOXES, THE IN-TRAY.)

THE IN-TRAY

THE RECURRING ENTRY ICON

This icon indicates Recurring Entries in your In-tray. When the icon appears in the New Entries folder, it will be red. In any other folder it will be blue.

THE AGENDA ENTRY ICON

This icon indicates Agenda Entries in your In-tray. When the icon appears in the New Entries folder, it will be red. In any other folder it will be blue.

THE DAY EVENT ICON

This icon indicates that the Entry is a Day Event. It can appear in the Notes View of the Daily and Weekly Agenda pages, the Month View of the Monthly Agenda page, and in the In-tray.

THE NOTE ICON

This icon indicates that the Entry is a Note. It can appear in the Notes View of the Daily and Weekly Agenda pages, the Month View of the Monthly Agenda page, and in the In-tray.
THE HOLIDAY ICON

This icon indicates the Entry is a Holiday. It can appear in the Notes View of the Daily and Weekly Agenda pages, the Month View of the Monthly Agenda page, and in the In-tray. It can also appear in the Pop-up Reminder dialog box when the Reminder is for a Holiday.

THE GREEN CHECKMARK ICON

This icon indicates many different things, depending on the context. When you open a list of users invited to an Entry in the In-tray, this icon indicates the user next to it has accepted the Entry in question.

(See also: THE DIALOG BOXES.)

THE RED “X” ICON

This icon indicates many different things, depending on the context. When you open a list of users invited to an Entry in the In-tray, this icon indicates the user next to it has refused the Entry in question.

(See also: THE DIALOG BOXES, THE MONTHLY PAGE.)

THE BLUE QUESTION MARK ICON

This icon indicates many different things, depending on the context. When you open a list of users invited to an Entry in the In-tray, this icon indicates the user next to it has not yet responded the Entry in question.

(See also: THE DIALOOG BOXES.)

THE ATTENDING BUT WOULD LIKE TO RESCHEDULE ICON

This icon appears in several places. When you open a list of users invited to an Agenda Entry in the In-tray, it indicates the user next to it will attend the Entry, but would prefer if it were scheduled for another time.

(See also: THE DIALOG BOXES.)

THE NOT ATTENDING BUT WOULD LIKE TO RESCHEDULE ICON

This icon appears in several places. When you open a list of users invited to an Agenda Entry in the In-tray, it indicates the user next to it will not attend the Entry, but would attend if it were scheduled for another time.

(See also: THE DIALOG BOXES.)

THE NOTES VIEW

THE UPCOMING AGENDA ENTRY ICON

This icon is the Reminder for an Upcoming Agenda Entry. It appears in the Notes View of your Daily and Weekly Agenda pages. You can open the corresponding Entry by double-clicking the Reminder.

THE UPCOMING TASK ICON

This icon is the Reminder for an Upcoming Task. It appears in the Notes View of your Daily and Weekly Agenda pages. You can open the corresponding Entry by double-clicking the Reminder.

THE UPCOMING DAILY NOTE ICON

This icon is the Reminder for an Upcoming Daily Note. It appears in the Notes View of your Daily and Weekly Agenda pages. You can open the corresponding Entry by double-clicking the Reminder.

THE UPCOMING DAY EVENT ICON

This icon is the Reminder for an Upcoming Day Event. It appears in the Notes View of your Daily and Weekly Agenda pages. You can open the corresponding Entry by double-clicking the Reminder.
THE UPCOMING HOLIDAY ICON

This icon is the Reminder for an Upcoming Holiday. It appears in the Notes View of your Daily and Weekly Agenda pages. You can open the corresponding Entry by double-clicking the Reminder.

THE DAY EVENT ICON

This icon indicates the Entry is a Day Event. It can appear in the Notes View of the Daily and Weekly Agenda pages, the Month View of the Monthly Agenda page, and in the In-tray.

THE NOTE ICON

This icon indicates the Entry is a Note. It can appear in the Notes View of the Daily and Weekly Agenda pages, the Month View of the Monthly Agenda page, and in the In-tray.

THE HOLIDAY ICON

This icon indicates the Entry is a Holiday. It can appear in the Notes View of the Daily and Weekly Agenda pages, the Month View of the Monthly Agenda page, and in the In-tray. It can also appear in the Pop-up Reminder dialog box when the Reminder is for a Holiday.

THE TASK VIEW AND TASK DISPLAY

THE TASK ICON

This icon appears in the Task View of your Daily Agenda page and in the Task Display. It indicates that the Task is due in the future.

THE OVERDUE TASK ICON (RED OUTLINE)

This icon appears in the Task View of your Daily Agenda page and in the Task Display. It indicates the Task’s due date has passed, but the Task has not yet been marked off as completed.

THE COMPLETED TASK ICON

This icon will appear in the Task View of your Daily Agenda page and in the Task Display. It indicates the Task has been completed.

THE BELL ICON

This icon may appear in Agenda Entries and Tasks on your Daily, Weekly, and Group Agenda pages, as well as in your Task Display. It indicates you have set a Reminder for the Entry.

THE PENCIL ICON

This icon may appear in Agenda Entries and Tasks on your Daily, Weekly, and Group Agenda pages, as well as in your Task Display. It indicates there is a Description included with the Agenda Entry, or Comments included with the Task. To view the Description or the Comments, open the Entry and select the Details tab.

THE PAPER CLIP ICON

This icon may appear in Agenda Entries and Tasks on your Daily, Weekly, and Group Agenda pages, as well as in your Task Display. It indicates there is a file attached to the Agenda Entry or Task. To open the Attachment, go to the Details tab of the Entry.

SPECIAL CURSORS

THE DRAG & DROP CURSOR

This cursor appears when you click and hold the mouse button on an Entry you can drag to another location. You can move Entries in this way on the Weekly and Monthly Agenda pages and in the In-tray.
THE CANNOT DROP IT HERE CURSOR

This cursor appears when you drag an Entry to a place where you cannot drop it. (For example, if you drag an Agenda Entry on the Monthly Agenda page and try to drop it on one of the splitters of the calendar grid.)

THE VIEW RESIZING CURSOR

Use this cursor to resize the views of your Daily, Weekly, and Monthly Agenda pages. Click any of the splitters that divide the views, and drag the splitter to resize the view.

THE MOVING CURSOR

Use this cursor to move a selected Agenda Entry on your Daily and Weekly Agenda pages. When you point at any part of the frame around a selected Entry (other than the two handles at the centre of the upper and lower edges), this cursor appears. Click the frame with this cursor and drag the Entry to another time slot.

THE RESIZING CURSOR

Use this cursor to change the duration of a selected Agenda Entry on your Daily and Weekly Agenda pages. When you point at either of the two handles that appear on the upper and lower edges of a selected Agenda Entry, this cursor appears. Click the handle with this cursor to change the Entry’s duration.

THE TOOLBARS

THE IN-TRAY BUTTON

Click this button on the toolbar to open your In-tray.

THE AGENDA BUTTON

Click this button on the toolbar to open an Agenda.

THE TASK DISPLAY BUTTON

Click this button on the toolbar to open your Task Display.

THE GROUP BUTTON

When you select the Group button on the toolbar, it opens the dialog box for opening a Group Agenda.

THE FIND ENTRY BUTTON

Click this button on the toolbar to locate the selected In-tray Entry in your Daily Agenda pages.

THE VIEW DAY BUTTON

Click this button on the toolbar to open the Daily Agenda page.

THE VIEW WEEK BUTTON

Click this button on the toolbar to open the Weekly Agenda page.

THE VIEW MONTH BUTTON

Click this button on the toolbar to open the Monthly Agenda page.

INCREASE TIME SLOT BUTTON

Click this button on the toolbar to increase the time slots in your Agenda pages. A time slot can last up to one hour.

DECREASE TIME SLOT BUTTON

Click this button on the toolbar to decrease the time slots in your Agenda pages. You can see
your time in very fine detail this way. The shortest
time slots will show your time in 5-minute intervals.

THE TURN ICONS ON/OFF BUTTON
Clicking this button displays or hides some of the icons that appear in the Daily, Weekly, and Group Agenda pages, as well as the Task Display.

THE NEW AGENDA ENTRY BUTTON
Click this button on the toolbar to open the New Agenda Entry dialog box.

THE NEW TASK BUTTON
Click this button on the toolbar to open the New Task dialog box.

THE NEW DAY EVENT BUTTON
Click this button on the toolbar to open the New Day Event dialog box.

THE NEW NOTE BUTTON
Click this button on the toolbar to open the New Daily Note dialog box.

THE PRINT BUTTON
Click this button on the toolbar to open up the Print dialog box or print the current view (it will print the current view if you are in the Task Display or the In-tray).

THE LAUNCH MAIL BUTTON
Click this button on the toolbar to launch your mail application (if you have set up your Mail Client Preferences to do so).

THE COLORS BUTTON
This button on the toolbar opens the Agenda Entry Colors dialog box. It allows you to change the color scheme of your Agenda Entries without having to change your Agenda Preferences.

THE YELLOW QUESTION MARK BUTTON
This button displays a message box containing information about the software version you are running.

THE POP-UP REMINDERS

THE ABOUT A DAY EVENT ICON
This icon appears in the Pop-up Reminder dialog box, the vCalendar Entries Found dialog box, and in the Reconciliation dialog boxes; it indicates that the dialog box refers to a Day Event.

THE ABOUT AN AGENDA ENTRY ICON
This icon appears in the Pop-up Reminder dialog box, the vCalendar Entries Found dialog box, and in the Reconciliation dialog boxes; it indicates that the dialog box refers to an Agenda Entry.

THE ABOUT A TASK ICON
This icon appears in the Pop-up Reminder dialog box, the vCalendar Entries Found dialog box, and in the Reconciliation dialog boxes; it indicates that the dialog box refers to a Task.

THE ABOUT A NOTE ICON
This icon appears in the Pop-up Reminder dialog box, the vCalendar Entries Found dialog box, and in the Reconciliation dialog boxes; it indicates that the dialog box refers to a Daily Note.
THE HOLIDAY ICON

This icon indicates the Entry is a Holiday. It can appear in the Notes View of the Daily and Weekly Agenda pages, the Month View of the Monthly Agenda page, and in the In-tray. It can also appear in the Pop-up Reminder dialog box when the Reminder is for a Holiday.

THE NEXT REMINDER BUTTON

This button appears in the Pop-up Reminder dialog box. Click it to view the next Reminder.

THE DATE CONTROL BARS

MORE ENTRIES ABOVE ICON

This icon appears in the Date Control Bar of the Daily, Weekly, and Group pages. It indicates there are more Entries earlier, which are not being displayed. Scroll up to see these Entries.

MORE ENTRIES BELOW ICON

This icon appears in the Date Control Bar of the Daily, Weekly, and Group pages. It indicates there are more Entries later, which are not being displayed. Scroll down to see these Entries.

MORE ENTRIES ABOVE & BELOW ICON

This icon appears in the Date Control Bar of the Daily, Weekly, and Group pages. It indicates there are more Entries earlier and later, which are not being displayed. Scroll up and down to see these Entries.

THE DOUBLE LEFT ARROW

This button appears on the Calendar and on the Daily, Weekly, Monthly, and Group Date Control bars.

- On the Daily and Group Date Control bars, this button takes you to the previous week.
- On the Weekly Date Control bar, this button takes you to the previous month.
- On the Monthly Date Control bar, this button takes you back six months.
- On the Calendar, this button will take you back a year.

THE LEFT ARROW

This button appears on the Calendar and on the Daily, Weekly, Monthly, and Group Date Control bars.

- On the Daily and Group Date Control bars, this button takes you to the previous day.
- On the Weekly Date Control bar, this button takes you to the previous week.
- On the Monthly Date Control bar and the Calendar, this button takes you to the previous month.

THE CALENDAR BUTTON

Clicking the Calendar button in the Date Control bars will bring up this box.
It allows you to select a specific date for which you would like to open your Agenda pages.  

(See also: THE DIALOG BOXES.)

THE RIGHT ARROW

This button appears on the Calendar and on the Daily, Weekly, Monthly, and Group Date Control bars.

• On the Daily and Group Date Control bars, this button takes you to the next day.
• On the Weekly Date Control bar, this button takes you to the next week.
• On the Monthly Date Control bar and the Calendar, this button takes you to the next month.

THE DOUBLE RIGHT ARROW

This button appears on the Calendar and on the Daily, Weekly, Monthly, and Group Date Control bars.

• On the Daily and Group Date Control bars, this button takes you to the next week.
• On the Weekly Date Control bar, this button takes you to the next month.
• On the Monthly Date Control bar, this button takes you forward a year.

THE TALLER ROWS BUTTON

This button appears on the Date Control bars of the Daily, Weekly, and Group Agenda pages. Clicking it makes the rows of your Agenda’s Day and Week Views taller. This allows you to see more details without changing the time slots.

THE SHORTER ROWS BUTTON

This button appears on the Date Control bars of the Daily, Weekly, and Group Agenda pages. Clicking it makes the rows in your Agenda’s Day and Week Views shorter. This allows you a better overview without changing the time slots.

THE STATUS BAR

THE OFF-LINE ICON

This icon is displayed to the right on the status bar. It indicates that you are currently working off-line, i.e. without a connection to the server.

THE ON-LINE ICON

This icon is displayed to the right on the status bar. It indicates that you are currently working on-line, i.e. with a connection to the server.

NEW ENTRIES ALERT ICON

This icon appears on your status bar, indicating there are new Entries in your In-tray.
THE GLOSSARY

ACCESS LEVEL

This controls who can access an Entry’s information. There are four levels of access: Normal, Confidential, Personal, and Public. You can set other users’ access rights to Entries of each level in the Access Rights dialog box.

AGENDA

The Agenda is a scheduling calendar, into which you write Entries (Agenda Entries, Day Events, Daily Notes, etc.).

AGENDA ENTRY

Agenda Entries are those Entries that are scheduled in your Agenda pages. The event may be a meeting, a course etc.—in short, anything that can be put into a time schedule.

You can include the location of the meeting in your Agenda Entry; invite other users to your Agenda Entries; and, you can make the Entry a recurring one. If you are not completely certain of all the details concerning your Agenda Entry (such as time, location etc.), you can make the Entry tentative. If you delete an Agenda Entry, or make any changes to it, the changes will automatically appear in the invited users’ Agendas as well.

ASSOCIATE

To open an attached file, it must be associated with an application capable of reading it. If your system cannot find an application to open an attached file, it will ask you to associate the file with an appropriate application.

ATTACHMENT

You can attach a file to an Agenda Entry or a Task using the Details tab of the New Agenda Entry/Task or Edit Entry/Task dialog boxes. Attached files allow you to include necessary material with an Agenda Entry or Task. Only one file may be attached to any given Agenda Entry or Task. You cannot attach files when working off-line.

ATTENDANCE STATUS

The Attendance status of an Agenda Entry indicates how you have (or have not) responded to it. Agenda Entries color coded by Attendance status appear as follows:

- Accepted Entry: green
- Unknown Status: yellow
- Refused Entry: red
- Accepted Tentative Entry: dark green
- Unknown Status (Tentative Entry): dark yellow
- Refused Tentative Entry: dark red

CREATOR

The person signed into the server when the Entry is created. They are not necessarily the owner of the Entry, since they may have created it while working as a designate in someone else’s Agenda.

DAILY NOTE

A Daily Note is either a one-time or a recurring note you can enter into your Agenda. It does not have a time, only the date on which it is displayed. Daily Notes can be up to 64 characters long and are displayed in the Notes View of you Agenda’s Daily and Weekly pages and in the Month View. You can send others a copy of your Daily Note.

DAY EVENT

A Day Event is either a one-time event or a recurring event that lasts an entire day. However, it does not block out any time in your Agenda’s Day View. You can still schedule Agenda Entries that day without creating a conflict. Day Events are displayed in the Notes View of you Agenda’s Daily and Weekly pages and in the Month View. You can invite others to your Day Events.

DEFAULT

The preset selection for an option. It is the option or value the program will use unless you specify otherwise.
**DESIGNATE**

A designate is someone who has the right to modify the Entries of another user in that user’s name. Designates can perform those operations specified by the access rights they have been granted. However, you can never set Access rights while working as a designate.

To grant designate rights, select Access Rights from the Options Menu.

**DOMAIN**

The domain makes up part of your e-mail address. For more information, consult your e-mail software manual.

**E-MAIL**

This is a contraction of the term “electronic mail”. It is the system that sends messages from one computer terminal to another.

**ENTRY**

Anything that appears in the In-tray or your Agenda pages (Agenda Entries, Tasks, Daily Notes, Holidays, and Day Events).

**FOREIGN USER**

A person who does not have an Agenda but is listed on the server. These users can be invited to Entries. They will receive their invitations by e-mail.

**GROUP TYPES**

There are four group types: Public, Private, Administrative, and Members Only. Not all types will be available in every case or to every user. Some dialog boxes have an ALL button to display all groups.

- **Public groups** are available for use to everyone on the system. However, they can only be modified by the group’s owner.
- **Private groups** are only available for use by their creators.
- **Administrative groups** are for use by everyone on the system. However, they can only be modified by those users with Administration Group rights (this is controlled by the system administrator).
- **Members Only groups** are available for use only by the members of the group.

**IMPORTANCE LEVEL**

You can assign your Agenda Entries different levels of importance. If you color code your Entries by Importance level, they appear as follows:

- Highest Importance: red
- High Importance: pink
- Normal Importance: turquoise
- Low Importance: blue
- Lowest Importance: green

**IN-TRAY**

The In-tray is where you manage the Entries you receive from other users. Every time another user invites you to an Entry, it appears in the New Entries folder of your In-tray. Entries that you have refused are found in the Entries you’ve Refused folder. In the Entries you’ve Accepted folder, you find Entries that you have accepted.

The Entries you have Sent folder contains those Entries to which you have invited others.

**LOCAL USER**

A user on the same server.

**NODE**

A node is a database located on a server. There may be, and often are, several nodes on one server. Nodes are identified by a number.

**OFF-LINE**

Not connected to the server. You will only have access to the Agendas you have downloaded to the local database.

**ON-LINE**

Connected to the server.
ORGANIZATION UNIT

This can be any subdivision of your organization and is related to your e-mail address. For more information, consult your e-mail software manual.

OWNERSHIP

An Entry is owned by the person or resource in whose name it was created. That is, you own the Entries you create while working in your own name (i.e. not working as someone else’s designate). Thus, Entries created by your designates while they work in your name are also owned by you. If you color code your Agenda Entries according to Ownership, they appear as follows:

- Entries you own: blue
- Entries you’ve been invited to: pink
- Tentative Entries you own: dark blue
- Tentative Entries you’ve been invited to: purple

Please note that when you color code Agenda Entries by ownership and you open another user’s Agenda, the Agenda Entries you (not the Agenda’s owner) own will appear in blue. This makes it easier for you to spot Agenda Entries you can edit in other users’ Agendas. (Even if you are in another user’s Agenda, you can still edit an Entry that you own.) However, if you are working in someone else’s Agenda as a designate, your designator’s Agenda Entries appear in blue, since you are working in their Agenda as though you were that person.

RECONCILIATION

Reconciliation is the process by which you make two versions of the Agenda consistent with one another, through reconciling the Entries that cause inconsistencies (that is, you decide which version of the Entry you want to keep). You may need to go through a reconciliation process when you upload your Off-line Agenda to your On-line Agenda, and when you import from or export to your palmtop.

REFRESH

Refreshing updates the Displays (Agenda, Task Display, and In-tray) to include any new Entries that have been created since the last refresh. You can refresh your Displays automatically or manually.

REMOTE USER

A user whose Agenda is on a different database. They can be invited to Entries in the same way as local users. However, a remote user cannot act as a designate.

RESOURCE

A resource is an inanimate object that has its own Agenda, such as a conference room or a piece of equipment.

SEARCH PARAMETER

When you search for people or resources in your system’s directory, you can enter search parameters to restrict your search to a specific set of information.

SERVER

The server is the computer to which the workstations of a network are connected. It is where the centralized database of all the user data is kept.

STATUS BAR

The status bar is displayed at the bottom of the Agenda window. To display or hide the status bar, select Status Bar in the View Menu.

The left area of the status bar describes the actions of menu items as you use the arrow keys to navigate through menus. This area also displays messages describing the actions of toolbar buttons as you click them and indicates the time and title of selected Entries.

The central area of the status bar will display an alert icon to let you know when there are new Entries in your In-tray, and furthest to the right another icon will indicate whether you are currently working on-line or off-line.

TASK

You can enter Tasks in your Agenda. These can either be linked to an Agenda Entry or be independent. A Task can have a start date and due
date, a start time and due time, as well as a Priority and Access level.

**TENTATIVE**

If you’re not completely certain of all the details concerning an Agenda Entry (such as time, location etc.), you can make it tentative when you create or edit it. Tentative Agenda Entries are not yet definite. To confirm a tentative Agenda Entry, deselect the Tentative checkbox in the Edit Entry dialog box.

**TIME SLOT**

A time slot is the individual block of time that each rectangle in your Agenda’s Day and Week Views represents. You can adjust the time each square represents (i.e. the size of the time slots) by:

- using the Increase time slot or Decrease time slot buttons on the toolbar; or,
- choosing Agenda from the Options Menu, and setting the Interval value on the Display page.

**TOOLBAR**

The toolbar is displayed across the top of the application window, below the menu bar. The toolbar provides quick mouse access to many tools used in your Agenda.

To hide or display the Toolbar, choose Toolbar from the View Menu.

**vCALENDAR**

vCalendar is a file format (*.vcs files are vCalendar files) that allows you to transfer data from your Agenda to other applications, including e-mail, word processing, web browsers, and other time management programs. The format is platform-independent, meaning you can transfer *.vcs files from one platform to another.

This format allows you to download Entries from web sites, schedule appointments with people using other scheduling software, and e-mail Entries to others.
KEY CONVENTIONS

**FILE MENU**

- Open an Agenda: Ctrl + A
- Open a Group Agenda: Ctrl + G
- Open your Tasks: Ctrl + T
- Open In-tray: Ctrl + I
- Print: Ctrl + P

**AGENDA MENU**

- New Entry: F2
- New Daily Note: F3
- New Day Event: F4
- Open Entry: F5
- Print Entry: F11
- Duplicate Entry: Ctrl + 2
- Reschedule Entry: Ctrl + M
- Delete Entry: Ctrl + Del
- View Day: F8
- View Week: F9
- View Month: F10

**DIRECTORY MENU**

- Search Directory: F12

**IN-TRAY MENU**

- Find Entry: Ctrl + F
- Delete Entry: Ctrl + Del

**TASKS MENU**

- New Task: F2
- Edit Selected Task: F5
- Print Selected Task: F11
- Duplicate Selected Task: Ctrl + 2
- Delete Selected Task: Ctrl + Del
- Sort by Description: F7
- Show Active Tasks: F6

**ALSO**

- Context-specific Help: F1
- Scroll forwards through items in a window: Tab
- Scroll backwards through items in a window: Shift + Tab
GETTING STARTED

SIGNING IN

You can work on your Agenda on-line or off-line. To access your Agenda on-line, you must be connected to a server; to work on your Agenda off-line, an off-line database must first be created.

You can open the Agenda as a person (not necessarily yourself) or a resource. However, you must always be able to supply the correct password.

ON-LINE

When you launch the application, you will see a dialog box asking you to sign in. Type in your user name and password. The password is case-sensitive, so be sure to use the correct case. When signing in on-line, you must indicate to which server you wish to connect. If the server name is not already entered, you must type it in. The server may have several nodes on which your information is stored. You need to specify the node to which you want to connect. For example, if your server name is "newton" and your data is stored on node 3, you would type in "newton, 3" as your server name. (If you only enter the server name, a dialog box containing a list of the nodes available on that server will appear. Select one of the nodes).

If you are not sure of your user name (the name by which the system knows you), you can search for it by clicking the Search button (see left). A Search dialog box will appear—type in one or several search parameters and click OK to begin your search. The names that match your search parameters will be displayed in the list box at the bottom of the dialog box. If there are several user names that match the search parameters you entered, select one and click OK or double-click the selected name. (See also, Searching, p. 55.)

Your Agenda will restore the windows you had open and their placement; as well, your In-tray and Reminders will always open automatically. However, Group Agendas you created during a previous session will not be restored.

OFF-LINE

When you open your Agenda off-line for the first time, you will need to create an off-line database, if you haven’t already configured your Off-line Agenda and

OFF-LINE

Not connected to the server. You will only have access to the Agendas you have downloaded to the local database.

ON-LINE

Connected to the server.
downloaded your On-line Agenda while working on-line (see Off-line Preferences, p. 68).

Begin by entering your user name in the Sign-In dialog box and choosing Off-line from the pull-down menu for the server name. If you have not configured your Off-line Agenda while working on-line, the Off-line Configuration dialog box will appear. Fill in your name, time zone, and where you would like to store your Off-line Agenda file. Click Browse to look for and select a location. Click OK once you have finished. The Sign-In dialog box will reappear, allowing you to sign in to the Off-line Agenda you have set up.

AS A RESOURCE

When you sign in to the system as a resource, you will only have the following capabilities:

- changing users’ access rights (i.e. setting their rights to view and/or modify Entries in the resource’s Agenda, as well as their right to invite the resource to Entries);
- changing the password for signing in as the resource.

Whenever you need to work as a resource, you should do so as a designate (see Working as a Designate, p. 29). To work as the designate of a resource, you must sign in as the resource and grant yourself the necessary Access rights. Then you can access the resource’s Agenda as a designate from within your own Agenda.

CHANGING YOUR PASSWORD

To change your password, select Change Password from the Options Menu. Your password may be up to 15 characters long, is case-sensitive (it distinguishes between uppercase and lowercase characters), and may include any alphanumeric character. To change your password, enter your old password in the upper edit box. Then enter your new password in the lower edit box. After you have changed your password, a dialog box will appear asking you to re-enter your new password, to ensure it is properly entered.

Depending on your system configuration, you may have to change your password after a certain time. You will then be prompted to change your password when you sign in, and your Agenda will not open until you have done so.

AS A RESOURCE

When you sign in to the system as a resource, you will only have the following capabilities:

- changing users’ access rights (i.e. setting their rights to view and/or modify Entries in the resource’s Agenda, as well as their right to invite the resource to Entries);
- changing the password for signing in as the resource.

Whenever you need to work as a resource, you should do so as a designate (see Working as a Designate, p. 29). To work as the designate of a resource, you must sign in as the resource and grant yourself the necessary Access rights. Then you can access the resource’s Agenda as a designate from within your own Agenda.

CHANGING YOUR PASSWORD

To change your password, select Change Password from the Options Menu. Your password may be up to 15 characters long, is case-sensitive (it distinguishes between uppercase and lowercase characters), and may include any alphanumeric character. To change your password, enter your old password in the upper edit box. Then enter your new password in the lower edit box. After you have changed your password, a dialog box will appear asking you to re-enter your new password, to ensure it is properly entered.

Depending on your system configuration, you may have to change your password after a certain time. You will then be prompted to change your password when you sign in, and your Agenda will not open until you have done so.
THE AGENDA PAGES

The pages of your Agenda are displayed in three basic formats: Daily, Weekly, and Monthly pages. These may display either your personal Agenda, or the Agenda of another user. Furthermore, you can display Group Agenda pages which show the Agenda Entries of a group of people and resources side by side. If you have been granted the rights by another user, you may also open any of these Agenda pages as a designate for that user.

The Agenda pages not only allow you to see the Entries, but also to edit existing Entries and add new Entries directly on the page.

OPENING AGENDAS

When you select Open Agenda from the File Menu, you have three options to choose from:

- An Agenda
- A Group Agenda
- A Group Agenda As Designate

You can also open an Agenda or Group Agenda from the toolbar by clicking the appropriate button (see left).

AN AGENDA

Clicking An Agenda (or clicking the Agenda button on the toolbar) opens the Open an Agenda dialog box, which lets you choose between opening your own Agenda or that of another user. If you wish to open your own Agenda, select the button:

“Modify your own Agenda”

Then click OK. This opens your Agenda, where you can edit and create Entries you own, and view Entries that you have been invited to or of which other users have sent you copies.

If you wish to view the Agenda of another user (without being able to work in that user’s name), select:

“View the Agenda of:”

Then fill in the name of the user whose Agenda you wish to see. To open a resource’s Agenda, type r:, re:, or res:, followed by the resource’s name. Then click the
Checkmark button (click the “X” button to cancel). This opens the Agenda of the user you have entered.

You can view its Entries according to the viewing rights the user has granted you, but you cannot make changes to those Entries you do not own. If you own an Entry in someone else’s Agenda, you can edit it in their Agenda. You can also create new Entries while viewing someone else’s Agenda, but you would own them, just as though you had created them in your own Agenda. (See also, Entries, p. 33 and Access Rights, p. 59.)

If you have been designated by other users to work in their Agendas, those users’ names appear in a box at the bottom of the dialog box. (If you have not been designated by any other user, this box will not appear.) To open one of these users’ Agendas and work in it as a designate, select:

“Modify, as designate, the Agenda of:”

Then select the name of the user and click OK. This opens the user’s Agenda for you to work in as designate. When you work in someone else’s Agenda as a designate, you work in that person’s (or resource’s) name. You can modify that user’s Entries, and if you create new Entries they will be owned by that user. But you can only view, edit, and create the designator’s Entries according to the rights they have given you for each Access level. (See also, Working as a Designate, p. 29 and Designate Rights, p. 60.)

A GROUP AGENDA

Choosing A Group Agenda (or clicking the Group button on the toolbar) calls up a dialog box in which you select the people and resources to be included in the Group Agenda you are creating. A Group Agenda lets you see the Day Views of several people and resources combined on one Agenda page. As when you view only one other user’s Agenda, you can view Entries according to the viewing rights each user has granted you, but you cannot make changes to Entries you do not own. (See also, The Group Agenda, p. 19 and Viewing Rights, p. 61.)

A GROUP AGENDA AS DESIGNATE

Choosing A Group Agenda As Designate lets you open several Agendas while working as a designate for another user. When you work in a Group Agenda as a designate, you can edit Entries owned by your designator, and if you create new Entries they will be owned by that user. But you can only view, edit, and create the
designator’s Entries according to the designate rights you have been given. (See also, The Group Agenda, p. 19 and Designate Rights, p. 60.)

Furthermore, you can only view the Entries of the other users in the Group Agenda according to the viewing rights each user has granted your designator, and you cannot make changes to Entries that your designator does not own.
THE DAILY AGENDA PAGE

Access the Daily Agenda page by choosing View Day from the Agenda Menu or by clicking the View Day button on the toolbar (see right).

The Daily Agenda page is divided into four parts:

- The Day View
- The Task View
- The Notes View
- The Date Control bar

You can resize the three views to suit your needs. The cursor changes when you point at the splitters that separate the views. The illustration to the right shows you how your new cursor will appear. Move the splitters by clicking them with this cursor and dragging them to their new location.
THE DAY VIEW

In the Day View, the day appears divided into time slots. You determine how much time each rectangle represents using the two buttons on the toolbar (see left). Decreasing the time slots allows you to see your time in fine details, down to five-minute intervals. Increasing the time slots gives you an overview of your entire day by putting up to one hour into each time slot.

Agenda Entries scheduled for the day you are displaying appear in their corresponding time slots, color-coded according to their importance, attendance status, or ownership, depending on the preferences you have set (see Color Coding, p. 65). Conflicting Agenda Entries will be displayed side by side—when you move your Agenda Entries around, they are resized on-screen to accommodate any conflicts created or eliminated.

You can add Agenda Entries to your day by clicking the time slot where you wish to begin your Agenda Entry and dragging the pointer to the End time. The block of time you have selected will be highlighted. You can type the Agenda Entry’s title directly into the block. If you want to add something more than a title and Start/End times, use the New Agenda Entry dialog box, which appears when you double-click the highlighted block. You can also access the dialog box directly (without selecting a block of time in the Day View) by choosing New Entry from the Agenda Menu or clicking the New Agenda Entry button on the toolbar (see left).

You can change the duration of Agenda Entries you own directly on your Agenda page. Click the Agenda Entry to select it. The field of the selected Agenda Entry turns white and its frame is highlighted (see left). The title and duration of the Entry are displayed in the status bar.

Two handles appear on the upper and lower edges of the Entry. Click the handle you want to use and drag it to lengthen or shorten the Agenda Entry. The Agenda Entry is resized and the display of any Agenda Entries occupying the same time slots is adjusted. When you change the duration of an Agenda Entry in this way, the new time and duration of the Entry are also displayed in the status bar.

You can move Agenda Entries in a similar way. When you point at any part of the highlighted frame other
than the two handles, another cursor appears (see right). To move an Agenda Entry, click its frame with this cursor and drag the whole Agenda Entry to its new location. The display of the Agenda Entry adjusts itself to accommodate any conflicts.

When you drag an Agenda Entry in this way, it snaps to the time slot interval you are using in your Day View. For example, if each of your time slots represents 15 minutes, your Agenda Entry will snap to the nearest quarter-hour division. If you wish to move an Agenda Entry to a finer time gradient, hold the **Ctrl** key while dragging. The time at which your Agenda Entry is placed appears in the status bar as you move it.

To delete an Agenda Entry, select it in the Day View and choose Delete Entry from the Agenda Menu. You can only delete Entries you own. If you have invited others to an Agenda Entry you delete, it is deleted in their Agendas and from your In-tray’s Entries you’ve sent out folder as well. If you do not want Agenda Entries you have refused to appear in your Agenda pages, you can specify this in the Agenda Preferences dialog box (see p. 71).

There are two ways to open the Edit Entry dialog box to modify Agenda Entries you own (you cannot edit Entries that you do not own). Select the Agenda Entry in your Day View and choose Open Entry from the Agenda Menu or double-click the Entry. If you only want to change the title of the Agenda Entry, highlight it and type the new title directly into the Entry in the Day View.

To view an Agenda Entry to which you have been invited, either double-click it or select it and choose Open Entry from the Agenda Menu.

Pressing the **Tab** key when an Agenda Entry is selected in the Day View selects the next Agenda Entry in chronological order. Pressing **Shift+Tab** takes you in reverse chronological order.
THE TASK VIEW

Your Tasks are displayed in this view. There are four different kinds of Tasks: Active Tasks, Tasks without a Start date but with a Due date in the future, Overdue Tasks, and Completed Tasks.

If you are viewing the Daily page of the current date, the following Tasks are listed in the Task View:

- Active Tasks (that is, Tasks whose Start date has passed)
- Tasks without a Start date but with a Due date in the future
- Overdue Tasks
- Completed Tasks (only if you completed them today, or if the current date was their Due date).

On a Daily page of a date in the past, the following Tasks are listed:

- Active Tasks whose Start dates had passed on that date;
- Completed Tasks if that date was the date of completion or their Due date;
- Overdue Tasks whose Start dates had passed on that date (note that they will be displayed as Active Tasks if their Due date had not passed).

On a Daily page for a future date, these tasks are listed:

- Tasks for which that date is the Start or Due date;
- Tasks without a Start date but whose Due date comes after that date.

A small box appears next to each Task, indicating its status (see left). Tasks are sorted by Due date, beginning with those Tasks that have no Due date. Other icons can also appear next to Tasks, providing you with more information.

You can create a new Task directly on the Daily Agenda page. Call up the New Task dialog box either by choosing New Task from the Agenda Menu, by clicking the New Task button on the toolbar, or by double-clicking below the existing Tasks in the Task View.
By double-clicking a Task, you call up the Edit Task dialog box, which lets you make changes to the Task. If you have finished your work on a Task, you only need to click the small box in front of its name in the Task View to mark it as a Completed Task.

You can also make changes to your Tasks by selecting a Task and using the Entry commands available from the Agenda Menu. (See Tasks, p. 42.) To delete a Task, select it in the Task View and choose Delete Entry from the Agenda Menu.

THE NOTES VIEW

Daily Notes, Day Events, Holidays, and Upcoming Reminders are displayed here. Next to each Entry an icon indicates what kind of Entry it is (see right). You can open these Entries by double-clicking them in the Notes View. If you double-click an Entry you own, the Edit Entry dialog box appears, allowing you to modify the Entry.

Double-clicking an Entry you don’t own or a Holiday opens the View Entry dialog box, which provides information about the Entry. It is easy to spot Entries you do not own in the Notes View—the owner’s name appears after such Entries. Double-clicking an Upcoming Reminder opens the Entry for which the Reminder was set.

You can create a Daily Note either by choosing New Daily Note from the Agenda Menu, by clicking the New Daily Note button on the toolbar, or by double-clicking in the Notes View below any other Entries already displayed there. (See Daily Notes, p. 40.) Day Events, also displayed in the Notes View, are created by choosing New Day Event from the Agenda Menu or by clicking the New Day Event button on the toolbar. (See Day Events p. 38.) Holidays can only be created by users with special authorization. If you have such rights, you can create or delete Holidays by choosing Holidays from the Directory Menu. (See Holidays, p. 44.)

To delete an Entry you own in the Notes View, select it and choose Delete Entry from the Agenda Menu. If you delete an Entry you have sent to other users, it will be deleted in their Agendas as well. To remove a Holiday or an Entry owned by someone else, open it and select “Remove from Agenda” on the Agenda tab of the View Entry dialog box.

DAILY NOTE
A Daily Note is a note you can enter into your Agenda. It does not have a time, but only a date that it is displayed on. Daily Notes can be up to 64 characters long, and are displayed in the Notes View of your Agenda’s Daily and Weekly pages and in the Month View.

DAY EVENT
A Day Event is an Entry that lasts for, or is valid for, an entire day. However, it does not block out any time in your Agenda’s Day View. Day Events are displayed in the Notes View of your Agenda’s Daily and Weekly pages and in the Month View.
THE DATE CONTROL BAR (DAILY PAGE)

The Date Control bar runs along the upper edge of your Daily Agenda pages. It displays the date of the Agenda page you are viewing and lets you turn the pages of your Agenda using its buttons (see left).

Clicking the Calendar button displays a pop-up calendar allowing you to open your Daily Agenda page to a specific date (see The Calendar, p. 45, for details on how to use it).

From this control bar you can also make the rows in your Day View taller or shorter. This allows you to see your Agenda Entries in more or less detail in your Day View, without changing the period of time each time slot represents. Use the Taller Rows button to make each row larger, showing more detail within each time slot. The Shorter Rows button makes each row smaller, allowing you to display more rows on the screen at one time.

At the far left of the Daily Date Control bar, you may see red arrows pointing upwards or downwards. They indicate that there are more Agenda Entries earlier or later in the day, which are not visible on-screen at the moment. Scroll up or down to see these Agenda Entries.
THE WEEKLY AGENDA PAGE

Access the Weekly Agenda page by choosing View Week on the Agenda Men, or by clicking the View Week button on the toolbar (see right).

The Weekly Agenda page is divided into three parts:

- The Week View
- The Notes View
- The Date Control bar

You can resize the two views to suit your needs. The cursor changes when you point at the splitters between the panes (see right). Move the splitters by clicking them with this cursor and dragging them to their new location.
THE WEEK VIEW

In the Week View, your week is divided vertically into the days of the week and horizontally into time slots. You determine how much time each slot represents using the two buttons on the toolbar (see left). Decreasing the time slots allows you to see your time in fine details, down to five-minute intervals. Increasing the time slots gives you an overview of your entire day.

Agenda Entries appear in the days and time slots where they are scheduled, color-coded according to their Importance level, Ownership or Attendance status, depending on your preferences. (See Color Coding, p. 65.) Conflicting Agenda Entries are displayed side by side. As you move your Agenda Entries around, they are resized to accommodate any conflicts created or eliminated.

You can change the duration of Agenda Entries you own directly in your Week View in the same way as in the Day View of your Daily Agenda page. Click the Agenda Entry to select it. The field of the Agenda Entry will turn white and its frame will be highlighted (see left). The title and duration of the Agenda Entry will be displayed in the status bar.

Two handles appear on the upper and lower edges of the highlighted Entry. Click the handle you want to use and drag it to change the duration of the Agenda Entry. The Agenda Entry will be resized and the display of any conflicting Agenda Entries will be adjusted. When you change the duration of an Agenda Entry in this way, the new time and duration of the Agenda Entry are displayed in the status bar.

You can move the Agenda Entry to another time or day in the Week View in a similar way. You will see that when you point at any part of the frame other than the two handles, another cursor appears (see left). To move an Agenda Entry, click its frame with this cursor and drag it to its new location. The Agenda Entry is resized and the display is adjusted to accommodate any conflicts.

When you drag an Agenda Entry in this way, it snaps to the time slot interval you are using in your Agenda. For example, if each time slot represents 15 minutes, your Agenda Entry will snap to the nearest quarter-hour division. To move an Agenda Entry to a finer time gradient, hold the Ctrl key while dragging.
You will see the time at which your Entry is currently placed displayed in the status bar as you move it.

In the Week View you create, delete, view, and modify Agenda Entries in the same way as you would in the Day View of your Daily Agenda page. (See The Day View, p. 7 for details.)

Pressing the Tab key when an Agenda Entry is selected in the Week View selects the next Agenda Entry in chronological order. Pressing Shift+Tab will take you in reverse chronological order.

**THE NOTES VIEW**

Every day displayed on your Weekly Agenda page has a corresponding Notes View at the bottom of the page. Like on the Daily Agenda page, Daily Notes, Day Events, Holidays, and Upcoming Reminders will be displayed in the Notes View, with icons indicating the kind of Entry (see right). Open these Entries by double-clicking them, which lets you edit or view them just as in the Notes View on the Daily page. You can also create and delete Entries in the same way as you would on your Daily Agenda page. (See The Notes View, p. 10 for details.)

**THE DATE CONTROL BAR (WEEKLY PAGE)**

The Date Control Bar runs along the top of the Weekly Agenda pages. It displays the dates of the week you are viewing and lets you turn the pages of your Agenda using its buttons (see right).

Clicking the Calendar button displays a pop-up calendar allowing you to open your Weekly Agenda page to a specific date (see The Calendar, p. 45, for details on how to use it).

From this control bar you can also make the rows in of the Week View taller or shorter. This allows you to see your Agenda Entries in more or less detail in your Week View, without changing the period of time each time slot represents. Use the Taller Rows button to make each row larger, showing more detail within each time slot. The Shorter Rows button makes each row smaller, allowing you to display more rows on the screen at one time.

At the far left of the Weekly Date Control bar, you may see red arrows pointing upwards or downwards. They indicate that there are more Agenda Entries earlier or later.
later in your Week View, which are not visible on-screen. Scroll up or down to see these Agenda Entries.
THE MONTHLY AGENDA PAGE

Access the Monthly Agenda page by choosing View Month from the Agenda Menu or by clicking the View Month button on the toolbar (see right).

The Monthly Agenda page is divided into two sections:

- The Month View
- The Date Control bar

THE MONTH VIEW

The Month View contains an entire month’s Entries. At the beginning and the end of the month, any grid squares not used for the current month display will show the days of the previous or following month in gray. The current date is displayed in red.

You can rearrange the splitters that form the calendar’s grid the same way you move the splitters between views in the other Agenda pages. Move the splitters by...
returns the calendar grid to its default setting

Daily Note
Day Event
Holiday
Refused Agenda Entry

AGENDA ENTRY
Agenda Entries are those Entries that are scheduled in your Agenda’s Day or Week Views. The event of an Agenda Entry may be a meeting, a course etc.—in short, anything that can be put into a time schedule.

DAILY NOTE
A Daily Note is a note you can enter into your Agenda. It does not have a time, but only a date that it is displayed on. Daily Notes can be up to 64 characters long, and are displayed in the Notes View of your Agenda’s Daily and Weekly pages and in the Month View.

DAY EVENT
A Day Event is an Entry that lasts for, or is valid for, an entire day. However, it does not block out any time in your Agenda’s Day View. Day Events are displayed in the Notes View of your Agenda’s Daily and Weekly pages and in the Month View.

clicking them and dragging them to their new location. To return to the evenly, divided default grid setting, click the Grid button on the Monthly Date Control bar (see left).

The month view displays Agenda Entries, Day Events, Daily Notes and Holidays. The names of Holidays appear in red next to the date along the upper edge of the grid square. Agenda Entries are listed first, followed by Notes, Day Events, and Holidays. The type of Entry is indicated by icons next to the Entries. Accepted Agenda Entries and Agenda Entries you haven’t yet replied to are simply displayed with their Start times; refused Agenda Entries are indicated by a red “X” icon. (See also, Display Preferences, p. 71.)

Many different functions can be performed within the Month View by pointing and double-clicking (or using corresponding Menu commands).

- Double-clicking the upper edge of a grid square opens the Daily Agenda page for that date.
- Double-clicking an Entry you own (or selecting it and choosing Open Entry from the Agenda Menu) allows you to edit it in the Edit Entry dialog box.
- Double-clicking an Entry you don’t own (or selecting it and choosing Open Entry from the Agenda Menu), opens the View Entry dialog box. It contains more information about the Entry and lets you respond to it.
- Double-clicking the blank space beneath any existing Entries in a grid square (or choosing New Entry from the Agenda Menu) opens the New Agenda Entry dialog box.

The Month View also lets you move Entries you own from one day to another by dragging them from one grid square to another. When you click an Entry you own and do not release the mouse button, the cursor changes to a drag-and-drop cursor (see left). This lets you know you have selected an Entry that you can move.

Select Entries by clicking them. Once an Entry is selected, you can scroll through all of the Entries in the same grid square using the up and down arrows on the keyboard. (Those grid squares containing more Entries than displayed will contain the icon shown to the right, indicating there is more to see below.)
To delete an Entry, select it and choose Delete Entry from the Agenda Menu. You can only delete Entries you own. If you delete an Entry you’ve sent to other users, it will be deleted in their Agendas as well.

If you do not want Agenda Entries you have refused to be displayed in your Agenda pages, you must specify this in the Agenda Preferences dialog box (see p. 71). To remove any other kind of Entry you do not own, open it and select “Remove from Agenda” on the Agenda tab of the View Entry dialog box.

**THE DATE CONTROL BAR (MONTHLY PAGE)**

The Date Control Bar runs along the upper edge of the Monthly Agenda pages. It displays the month and year of the Agenda page you are viewing and lets you turn the pages of your Agenda using its buttons (see right).

Clicking the Calendar button will display a pop-up calendar allowing you to open your Agenda to a specific date. (See *The Calendar*, p. 45, for details on how to use it).
THE GROUP AGENDA

The Group Agenda is a convenient way of scheduling an event with various users. It allows you to open the Day Views of several people and resources side by side, so you can view the Agenda Entries of others and schedule an event with them at a time when everyone is available. Each person or resource included in the Group Agenda has a column with their name at the top, in which their individual Day View is displayed. The column to the far left is a Combined View—the times at which everyone is available will appear as empty time slots here.

You open a Group Agenda by selecting Open Group Agenda from the File Menu (File Menu, Open Agenda, A Group Agenda) or clicking the Group button on the toolbar (see left). This calls up the Selection for Group Agenda dialog box, where you create a list of the people and resources whose Agenda Day Views are to be included in the Group Agenda.
Type the name of the person or resource in the edit box and click Checkmark to add the name to the list. (The "X" button erases the name from the edit box). You can search for people, groups, or resources by clicking the Search button (see Searching, p. 55). You can also click the Group button to select a group for your list (see Adding Groups, p. 50). To delete a name from the list, select it and click Delete. Click OK once you have completed your list, and a Group Agenda will be created.

Return to the Selection for Group Agenda dialog box to add or remove people and resources once you have opened a Group Agenda. Click the Add/Remove button on the Group Agenda’s Date Control bar (see right) to do so.

In the Group Agenda, you can schedule Agenda Entries using the Combined column, just as you would on your regular Daily Agenda page (see The Day View, p. 7). In the New Agenda Entry dialog box that appears, the names of the people and resources in the Group Agenda will already appear on the list of participants. You can still add to and delete from the list as you would when creating any other Entry.

When working in a Group Agenda you can also schedule an Agenda Entry in a single user’s Agenda, as though you had opened only that person’s or resource’s Agenda. The Combined View automatically adjusts to accommodate any such Entries.
**In-Tray**

**Helena Carlsson**

### New entries
- Visit from ACME Inc.
- Breakfast with John and Lisa
- Company Outing
- Manuel out of office until noon
- Departmental Meeting

### Entries you've accepted
- Departmental Meeting
- Monthly group meeting
- Meeting: Summer session planning
- Department Lunch
- Meeting: Summer session planning
- Canada Day
- Rick Mantras here from Boston

### Entries you've sent out
- Department meeting
- Lunch at the bistro (tentative)
- General company meeting
- Planning Committee
- Rod Cranston in from Montreal
- Helena out for the day

### Entries you've refused
- Marie-Joë Grégoire: Wed, Apr 9, 1997
- Manuel Garcia: Mon, Apr 14, 1997 at 9:00 am - 10:00 am
- Manuel Garcia
- Manuel Garcia: Thu, May 1, 1997 at 11:00 am - 12:00 pm
- Manuel Garcia: Tue, Apr 28, 1997 at 10:00 am - 11:00 am
- Manuel Garcia: Fri, Apr 11, 1997 at 12:30 pm - 2:00 pm
- Manuel Garcia: Fri, Apr 4, 1997

---

**THE IN-TRAY**

The In-tray is where you receive and manage Entries (Agenda Entries, Day Events, Daily Notes, or Holidays) from other users. The In-tray also contains a listing of the Entries you have accepted, refused, or sent to others. To access your In-tray, click the In-tray button on your toolbar (see left) or choose Open In-tray from the File Menu.

---

**GENERAL**

When you open your In-tray, you will see a folder labeled with your name. If you have opened other Agendas to work in them as a designate, folders will also appear labeled with the names of the users for whom you are working as a designate. Open or close folders by clicking them. Opening the folder with your name reveals four folders:

- **New Entries**
- **Entries you've accepted**
- **Entries you've sent out**
- **Entries you've refused**

Opening any of these folders (by clicking them) displays a listing of the folder's contents. Each item in the list will be preceded by an icon, identifying the item as:

- **AGENDA ENTRY**
- **DAILY NOTE**
- **DAY EVENT**
- **ENTRY**

Anything that appears in the In-tray or your Agenda pages (Agenda Entries, Tasks, Daily Notes, Holidays, and Day Events).
a Note, a Holiday, an Agenda Entry, Day Event, or recurring Entry (see right).

By clicking or double-clicking in the In-tray, you can handle your Entries in a number of ways.

Clicking an Entry’s icon displays a list of all the people and resources to whom the Entry has been sent. The icon next to each name indicates how the person or resource has responded to the Entry (see right). Your name appears on the list of people and resources in bold type. If you double-click your name, the Reply dialog box appears (see Replying to an Invitation, below).

When you click the icon of a recurring Entry, the Entry’s recurrences are listed. An icon indicates what kind of recurring Entry it is (an Agenda Entry, Daily Note, a Day Event, or a Holiday icon). Clicking these icons displays the list of people and resources for that particular recurrence.

Double-clicking the title (not the icon) of an Entry you have received from another user opens either the Fast Reply dialog box or the View Entry dialog box (see Replying to an Invitation, below), depending on your In-tray Preferences for the different In-tray folders (p. 72). Double-clicking an Entry that you’ve sent out will always call up the Edit Entry dialog box.

You can also drag Entries from one folder to another. Your Agenda will automatically make the necessary changes.

To open your Agenda to the Daily page on which a selected Entry appears, click the Find Entry button on the toolbar or select Find Entry from the In-tray Menu.

You can print an Entry in your In-tray by selecting it and choosing Print Entry from the In-tray Menu. If you click the Print button on the toolbar, your Agenda will print the entire In-tray.
REPLYING TO AN INVITATION

If you have set your In-tray preferences so that double-clicking a new Entry lets you reply to it, the Fast Reply dialog box appears when you double-click a new Entry’s title (see left). Select the appropriate message in the dialog box. To send an e-mail message with your reply, click the Mail Message button and enter your message in the Mail Message dialog box that appears. Click OK when you have finished. (See also, Mail Message, p. 87 and In-tray Preferences, p. 72)

If you have set your In-tray preferences so that double-clicking a new Entry lets you view it, the View Entry dialog box appears. This dialog box contains all the information about the Entry, and lets you reply to it on the Reply or the Agenda tab (depending on the type of Entry). These tabs look and function just like the Fast Reply dialog boxes. (See also Entries, p. 33.)

Once you have dealt with an Entry, it is put in the appropriate In-tray folder, as an Entry you have either accepted or refused. If you choose to reply later, the Entry will remain in the New Entries folder.

THE IN-TRAY FOLDERS

The In-tray folders are your Agenda’s record of all incoming and outgoing Agenda Entries, Day Events, Daily Notes, and Holidays. The New Entries folder contains all those Entries you have received from others to which you have not yet responded. The other three folders contain Entries for the time ranges set in your In-tray preferences (see In-tray Preferences, p. 72).

NEW ENTRIES

The New Entries folder contains all Entries to which you have not responded. It is a good idea to check this folder from time to time to see what Entries you have received.

If you minimize your Agenda’s window, the icon on screen changes to let you know when new Entries appear in this folder. If you are working in your Agenda, an In-tray icon appears in the status bar, indicating there are new Entries in this folder. (See left.) You set the refresh rate for this function yourself (see Agenda Preferences — Notification, p. 72).
**ENTRIES YOU’VE ACCEPTED**

This folder contains Entries you have accepted, that is, Agenda Entries you have chosen to attend, and other Entries that you have kept in your Agenda. You can change your reply to the Entries in this folder in the same way you reply to a new Entry (see above). Once you have changed the reply to an Entry, it will be put in the appropriate In-tray folder.

**ENTRIES YOU’VE SENT OUT**

This folder contains a list of the Entries you have sent out to other users. The length of time Entries remain on the list depends on your preferences.

You can delete these Entries while working in the In-tray. To do so, select the Entry and choose Delete Entry from the In-tray Menu. When you delete an Entry, it is removed not only from your Agenda, but also from the Agendas and In-trays of all the people and resources to whom you have sent the Entry.

**ENTRIES YOU’VE REFUSED**

This folder contains Entries you have refused, that is, Agenda Entries you have chosen not to attend, and other Entries that you have removed from your Agenda. You can change your reply to the Entries in this folder in the same way you reply to a new Entry (see above). Once you have changed the reply to an Entry, it will be put in the appropriate In-tray folder.
THE TASK DISPLAY

You can keep track of your Tasks by entering them into your Agenda. Some Tasks are displayed in the Task View of your Daily Agenda pages, but to manage your Tasks and get an overview of them, open the Task Display. It contains all of your Tasks: active (i.e. Tasks whose start dates have passed), incomplete, completed, and overdue.

OPENING A TASK DISPLAY

To open your Task Display, either select Open Tasks from the File Menu or click the Task Display button from the toolbar (see left).

When you select Open Tasks from the File Menu, you will be given three options:

- Your Tasks
- Modify Other’s Tasks as Designate
- View Other’s Tasks

YOUR TASKS

Choosing “Your Tasks” will open your Task Display, where you can work on your Tasks: you can view, edit, and create Tasks in your Agenda.

OWNERSHIP

An Entry is owned by the person or resource in whose name it was created (by that user or by a designate).
MODIFY OTHER’S TASKS

Choosing “Modify Other’s Tasks” lets you open someone else’s Task Display and work on that user’s Tasks as a designate (they must have given you the right to do so). When you work on someone else’s Tasks as a designate, you can view, edit, and create that user’s Tasks, according to the rights you have been given. (See also, Working as a Designate, p. 29 and Designate Rights, p. 60.)

VIEW OTHER’S TASKS

Choosing “View Other’s Tasks” lets you open someone else’s Task Display to view their Tasks. You only see the information for which you have been given Viewing Rights. Depending on these rights, you will be able to view some or all Tasks, but you will not be able to make any changes to them. (See also, Task Viewing Rights, p. 62.)

WORKING IN THE TASK DISPLAY

You can choose to display all or only some Tasks in the Task Display by selecting one of the following commands from the Tasks Menu:

- Show All Tasks
- Show Incomplete Tasks
- Show Completed Tasks
- Show Active Tasks

You can also choose how you wish to sort the Tasks you want to display by selecting one of the following commands from the Tasks Menu:

- Sort Tasks by Description
- Sort Tasks by Due Date
- Sort Tasks by Start Date
- Sort Tasks by Priority

Another way to sort your Tasks is by clicking the heading of the column by which you want your Tasks sorted.

You can manage your Tasks using the commands from the Tasks Menu. If you are working in your own Task Display or working as a designate, you also have the option of using the buttons at the bottom of the display and the New edit box at its top (see illustration on p. 25).

THE TASK DISPLAY BUTTONS

- **Completed** Clicking this button will mark the Task you have selected from the list as being completed. The Task will be marked as 100% Completed and the completion date will be filled in automatically.

- **New...** This button calls up the New Task dialog box. Selecting New Task from the Tasks Menu will do the same thing. You may also use the New edit box at the top of the Task Display to create a new Task.

- **Edit...** Clicking this button will open up the Edit Task dialog box for the Task you have selected from the list. You can also double-click a Task, or choose Edit Selected Task from the Tasks Menu, to call up the Edit Task dialog box.

- **Delete** Clicking this button will delete the Task you have selected from the list. Choosing Delete Selected Task from the Tasks Menu will do the same thing.

DESIGNATE

Someone who has the right to modify the Entries of another user, in that user’s name. Designates can perform those operations specified by the access rights that the other user has granted them. However, you can never set other users’ (or your own) access rights while working as a designate for someone else.

To grant someone designate rights, select Access Rights from the Options Menu.
When viewing someone else’s Tasks, you cannot make any changes in the Task Display. Therefore, the buttons and the New edit box mentioned above are not available. If you double-click a Task in the list here, the View Task dialog box appears with detailed information about the Task.

(See also *Tasks*, p. 42.)
DESIGNATES

A designate is someone who has the right to work in the Agenda of another user on that user’s behalf. However, designates can only carry out those operations the owner of the Agenda has granted them the right to perform.

GRANTING DESIGNATE RIGHTS

The Access Rights dialog box (Directory Menu, Access Rights) lets you give designate rights to other users. You can choose what rights each of your designates will have in your Agenda using the Designate tab of the Access Rights dialog box. (See Designate Rights, p. 60.)

WORKING AS A DESIGNATE

IN A REGULAR AGENDA

In the Open an Agenda dialog box (File Menu, Open Agenda, an Agenda) you have the option of opening another user’s Agenda as a designate (provided that you have been granted the right to do so). Select “Modify, as designate, the Agenda of:” and then click the name of the person or resource whose Agenda you want to open in the list box (see Opening Agendas, p. 3).

When you choose to work in someone else’s Agenda as a designate, you can view, edit, delete, and add Entries owned by that user, according to the rights you have been given. These designate rights are defined by the owner of that Agenda. For example, you may or may not have access to confidential Entries in the Agenda.

The Entries you create while working as a designate in an Agenda are owned by the Agenda’s owner; you can only edit them when working as that user’s designate. If you switch to the In-tray when you have opened an Agenda as a designate, you will see both your own folders and those of the person for whom you are working as a designate displayed in the same window.

NOTE: When a designate creates an Entry, it will be displayed in the owner’s Agenda and (if others have been invited) in his or her In-tray exactly as if that user had created them. Therefore, it’s a good idea to send the owner an e-mail about the Entry, to inform that person about what has been added on their behalf.
In a Group Agenda

Opening a Group Agenda as a designate lets you create Agenda Entries using the Group Agenda while working as a designate for someone else. To do this, choose Open Agenda from the File Menu, then select A Group Agenda As Designate from the submenu. This opens the Designator Selection dialog box, where you choose the user for whom you wish to work as a designate.

Once you have selected for whom you are working as a designate, the Selection for Group Agenda dialog box appears, where you select the people and/or resources who will be included in the Group Agenda. When you have finished selecting people/resources, a Group Agenda will be created for you. (See also, *The Group Agenda*, p. 19).

In the Task Display

To open the Task Display of another user as a designate, select Open Tasks from the File Menu, and choose Modify Other’s as Designate from the submenu. If you have been given designate rights by more than one user, the Designator Selection dialog box appears (see above). Select which user’s Task Display you wish to open.

When you work as a designate in a Task Display, you can view and modify those Tasks to which you have been given designate rights. Any Tasks you create while working as a designate in a Task Display will be owned by the user in whose name you are working. You will only be able to edit them when working as that person’s designate. (See also *The Task Display*, p. 25.)

As a Resource Designate

Whenever you need to work in the Agenda of a resource, you should do so as a designate. Unless someone else has given you designate rights for the resource, you must sign in to the system as the resource and grant yourself the necessary rights. (To do so, you must be able to supply the resource’s password.)

When you sign in as a resource, you can only perform the following functions:

- Change the assigned access rights (setting designate, viewing and scheduling rights for yourself and other users on the system)

Resource

A resource is an inanimate object that has its own Agenda, such as a conference room or a piece of equipment.
- Change the password for signing in as the resource.

Grant yourself the necessary designate rights. You can then access and work in the resource's Agenda as a designate from within your own Agenda, as you would to work as a designate for another person (see p. 29).
ENTERIES

Anything you or other users enter in your Agenda is defined as an Entry. To accommodate the range of different things that you might want to include in your Agenda, there are five types of Entries: Agenda Entries, Day Events, Daily Notes, Tasks, and Holidays.

AGENDA ENTRIES

Agenda Entries are those Entries scheduled for a specific time. They appear in the Day, Week, and Month Views. You can invite others to your Agenda Entries and make them recurring events.

CREATING AGENDA ENTRIES

Enter new Agenda Entries into your Agenda using the New Agenda Entry dialog box. You can access it in a number of ways:

- Select New Entry from the Agenda Menu.
- Click the New Agenda Entry button on the toolbar (see left).
- In the Day View of your Daily Agenda page or the Week View of your Weekly Agenda page, you can double-click the time slot where you want to schedule your Agenda Entry.
- In the Day View and Week View, you may also select a block of time that take up more than one time slot, type in the title of your Agenda Entry, and then double-click the selected block of time. The title and times will already be entered in the dialog box that is called up.
- In the Month View of your Monthly Agenda page, you can double-click below any existing Entries in the grid square for the date where you want to add your Agenda Entry.

The New Agenda Entry dialog box consists of five tabs: General, People/Resources, Repeating, Details, and Reminders. Each tab lets you add certain features to your new Agenda Entry.

The General tab lets you enter the basic information about your Agenda Entry: times, date, and location. You also assign your Agenda Entry an importance level and an access level here. The access level will restrict the information others can see about the Entry. (See also, Access Rights, p. 59.) If you are not complete-
ly certain of the details concerning your Agenda Entry (such as time, location etc.), you can make it tentative. Once the details are confirmed, you can edit the Entry to make it definite.

You can check for conflicts to see if the Agenda Entry you are creating overlaps with other Agenda Entries in your Agenda. If there is a conflict, the Agenda can suggest another time for the Entry when it will not create a conflict (see, Scheduling Conflicts and Suggest Another Date or Time, p. 35).

Use the People/Resources tab to invite other people and resources to the Agenda Entry you are scheduling. Create the list using the edit box at the top of the tab (see Creating Lists, p. 49). The Agenda Entry will appear in the Agendas and In-trays of the people and resources on this list. Should you make any changes the Entry, they will appear automatically in the invited users’ Agendas as well.

You can make your Agenda Entry a recurring Entry using the Repeating tab of the dialog box. This is very useful for scheduling events that take place on a regular basis: a weekly meeting, a monthly deadline, etc. You can choose at what interval to schedule the recurring Agenda Entry and how far into the future the Entry should continue to be scheduled. The Agenda can check to see if any of the recurrences conflict with existing Agenda Entries. The Agenda can also suggest another date or time for any recurrence that causes a conflict with existing Entries.

The Details tab provides space to enter a description or details about your Agenda Entry. The description can be up to 32,000K long. You can type directly into the edit box or use the cut (Ctrl-X), copy (Ctrl-C), and paste (Ctrl-V) commands to insert material from elsewhere.

With the Attachments section of the Details tab, you can include documents you need for your meeting in your Agenda Entry. To attach a document, click Attach and select the document you wish to attach. Should you change your mind, click Remove to detach a file from your Entry. You can only attach one file to each Agenda Entry. If you have installed the application required to open the file you are attaching, the application’s icon will appear next to the attached file’s name. Otherwise, a generic icon will be used.

To open an attachment, double-click its icon. If the file is not associated with an application, you will be asked
to associate it in the Associate dialog box. Sometimes an attached executable file can not automatically be identified as such – in that case you may be able to execute it from this dialog box by selecting “Execute” from the pull-down menu and clicking OK.

The Reminders tab lets you set Reminders for the Entry you are creating. Set the Reminders by selecting the “On” checkbox and then entering when and how you wish to be reminded. If you have already set the Default Reminder on in Entry Defaults (see p. 74), you can change the Reminder for the Entry you are creating here. (See also Reminders, p. 47.)

**SCHEDULING CONFLICTS**

**Conflicts Found**

When you move or reschedule an Agenda Entry and create a scheduling conflict with one or more existing Agenda Entries in the process, you will be alerted to the conflict by a Conflicts Found dialog box. It will ask you whether or not you still want to move the Agenda Entry. You can go ahead and make the move in spite of the conflict, or you can cancel it. You also have the option of viewing the conflict before making your decision.

You can also check for conflicts at any time by clicking Check Conflicts on the General tab of the New Agenda Entry or Edit Agenda Entry dialog boxes. A red “X” will appear next to those Entries with a conflict.

**Conflict Details**

To view the details of a conflict either double-click the Agenda Entry that causes the conflict or click View in the Conflicts Found dialog box.

The Details of Conflict dialog box provides more information about conflicts caused by the Agenda Entry that you are creating, editing, or rescheduling.

- The left-hand list box displays the invited people and resources for whom your Agenda Entry causes one or more scheduling conflicts.
- The right-hand list box shows the Agenda Entries that are conflicting with your Entry in the Agenda of the person or resource that you have selected in the left-hand list box.

Click OK to dismiss the dialog box.
SUGGEST ANOTHER DATE OR TIME

When you create or edit an Agenda Entry, you can ask your Agenda to suggest a different day or time for the Entry by clicking Suggest a Date/Time on the General tab. In the Suggest another Time/Date dialog box that appears, you specify the range of dates and times for your search. You can also choose to search for a new time within your Normal or your Extended hours, which you set in your Scheduling Preferences (see p. 65). You can also limit the number of suggestions that will be displayed.

EDITING AGENDA ENTRIES

You can edit Agenda Entries you own by double-clicking them on the Agenda page or in the Entries you’ve sent out folder of your In-tray. You can also select the Agenda Entry on your Agenda page and choose Open Entry from the Agenda Menu.

Use the Edit Entry dialog box to modify an Agenda Entry you have scheduled. You make a tentative Agenda Entry definite and modify the Agenda Entry’s title, location, date, times, Importance level, and Access level. You can add or delete people or resources from the list of those invited to your Entry, edit the Agenda Entry’s description, and add, remove, or associate attached files. You can create and link new Tasks to the Entry you are editing, and set reminders for both the Entry and its linked Tasks. The tabs of this dialog box function in the same way as the tabs of the New Entry dialog box.

Click OK only when you have completed all the changes and additions you want to make to the Agenda Entry. If other people and resources have been invited to the Entry, the modifications will also be made in their Agendas. Should you change the date or time of the Agenda Entry, it appears in the New Entries folder in the In-trays of invited users.

When you edit an Agenda Entry, you can create and link Tasks to it. For example, if you need to prepare a report for the meeting which you have scheduled, you may want to link a Task to the Entry telling yourself to prepare the report. Tasks created in this way are displayed in the Task View and the Task Display, along with all of your other Tasks (see The Task View, p. 9 and The Task Display, p. 25).
The Linked Tasks tab of the dialog box lists all the Tasks linked to the Agenda Entry. You can manage them with the buttons beneath the list box:

- To make changes to existing linked Tasks, double-click the Task in the list box.
- To create and link a new Task, click New.
- To delete a linked Task, select the Task and click Delete.
- To unlink a Task from the Agenda Entry, select the Task and click Unlink.

When you print an Agenda Entry with Tasks linked to it, the Tasks will also be printed.

You can change your reply to an Agenda Entry using the Reply tab. You may have scheduled an Entry for yourself and others, but can no longer attend. To remove yourself from the Entry, but not cancel it for the other invited users, you can simply change your reply to "I will not attend."

**VIEWING AGENDA ENTRIES**

When you double-click an Agenda Entry you do not own, your Agenda opens the View Entry dialog box. You can only view the information displayed here—you cannot edit an Entry you do not own. When you select an Agenda Entry you own, the Edit Entry dialog box appears, since you have the right to edit those Entries.

The View Entry dialog box lists the following information about your Entry:

- Owner and Creator
- Title
- Location
- Date
- Start time, Duration, and End time
- Importance level
- Access level

You can also see a list of the people and resources invited, the Tasks linked to the Agenda Entry, and the Entry’s description. To add a linked Task to the Agenda Entry, click New on the Linked Tasks tab of the dialog box. This Task will appear in your Task View and Task
Display along with all your other Tasks. (See also, The Task View, p. 9 and The Task Display, p. 25.)

On the Details tab of the dialog box, the Agenda Entry description and any attachment included with the Agenda Entry are displayed. If the attached file is associated to an application that is installed on your system, you can open it by double-clicking its icon. Sometimes you will have to associate the file to the appropriate application before being able to open it (see p. 35).

The only information you can change here is the Reminder settings and your reply, which you do directly on the Reminders and Reply tabs of the dialog box.

If the Entry is a recurring one, a list at the bottom of the dialog box contains the recurrences of the Agenda Entry. The icon next to each recurrence indicates your responses. A green checkmark indicates that you have accepted the Entry for that recurrence, a red “X” that you have refused it, and a blue question mark that you have not yet responded to the recurrence.

DAY EVENTS

A Day Event is either a one-time event or a recurring event that lasts an entire day. However, it does not block out any time in your Agenda’s Day View. You can still schedule Agenda Entries that day without creating a conflict. For example, you may want to enter into your Agenda that someone from another company will be visiting your office for the day. You could enter this as a Day Event. If you then had a specific time commitment with that person during the course of the day, you would enter it as a regular Agenda Entry, blocking off the time in your Agenda.

Day Events are either one-time or recurring events, to which you can invite others. They are displayed in the Notes View of your Daily and Weekly Agenda pages and after Agenda Entries and Daily Notes in the day’s grid square on the Monthly Agenda page.

CREATING DAY EVENTS

Create a new Day Event using the New Day Event dialog box. Open it either by choosing New Day Event on the Agenda Menu or by clicking the New Day Event button on the toolbar (see right). This dialog box is structured the same way as the New Agenda Entry dialog box.
Apart from title and date, you also assign your Day Event an Access level. You can invite other people and resources to your Day Event, make it a recurring Entry and set reminders for it, as you would with an Agenda Entry. (See also, Creating Agenda Entries, p. 33).

Since Day Events are not designed to indicate specific time commitments with which you might want to include descriptions and attachments, the New Day Event dialog box does not have a Details tab.

EDITING DAY EVENTS

The Edit Entry dialog box appears when you double-click a Day Event you own on an Agenda page or in your In-tray. You can also open this dialog box by selecting the Day Event on the Agenda page and choosing Open Entry from the Agenda Menu.

In the Edit Entry dialog box, you can make changes to Day Events you own in the same way as you can make changes to Agenda Entries that you own. However, you will find an Agenda tab instead of a Reply tab. On this tab you can change the Day Event’s Agenda Status, that is, whether you want to keep it in your Agenda. If you do not want to keep the Day Event in your Agenda, but do not want to delete it from all invited users’ Agendas, select “Remove from Agenda”.

For the same reasons that there is no Details tab, you can’t link Tasks to Day Events.

When you edit a Day Event to which you have invited others, the changes will also appear in their Agendas. If you change the date of the Entry, it will be displayed in the invited users’ In-trays as a new Entry. Any other changes (title, Access level, etc.) simply appear in their Agendas.

VIEWING DAY EVENTS

As with Agenda Entries, the View Entry dialog box appears when you double-click a Day Event you do not own or if you select the Day Event and choose Open Entry from the Agenda Menu. It is easy to identify a Day Event owned by another user in your Notes View, since the owner’s name appears next to the Entry.

The View Entry dialog box lets you see all the information available about the Day Event, but does not let you make changes to it. However, you can set or change your Reminder for the Day Event using the

OWNERSHIP

An Entry is owned by the person or resource in whose name it was created (by that user or by a designate).
Reminders tab of this dialog box, and decide whether or not to keep it in your Agenda on the Agenda tab.

**DAILY NOTES**

A Daily Note is either a one-time or a recurring note you can enter into your Agenda. It does not have a time, only the date on which it is displayed. Daily Notes can be up to 64 characters long and are displayed in the Notes View of your Agenda’s Daily and Weekly pages and in the Month View. You can send others a copy of your Daily Note.

**CREATING NOTES**

Create new Daily Notes using the New Daily Note dialog box, which you open by either choosing New Daily Note from the Agenda Menu, by double-clicking in the Notes View below any other Entries already displayed there, or by clicking the New Note button on the toolbar (see right).

The New Daily Note dialog box is structured the same way as the New Agenda Entry dialog box. Write your Note in the Title edit box – this is the text that will be displayed in the Notes View. Apart from title and date, you give your Daily Note an access level. You can use the tabs of the New Daily Note dialog box to make your Daily Note a recurring one, set a Reminder for it, and send copies of it to other users, as you would when creating an Agenda Entry (see p. 33).

**EDITING NOTES**

The Edit Entry dialog box appears when you double-click a Daily Note you own on an Agenda page or in the Entries Sent folder in your In-tray. You can also open this dialog box by selecting the Daily Note on the Agenda page and choosing Open Entry from the Agenda Menu. In this dialog box you can edit a Daily Note in the same way you edit a Day Event (see p. 39).

**VIEWING NOTES**

The View Entry dialog box appears when you double-click a Daily Note that you do not own, or if you select the Daily Note and choose Open Entry from the Agenda Menu. It is easy to identify a Daily Note owned by another user in your Notes View, since the owner’s name is written next to the Entry. The dialog box looks and behaves exactly like the View Entry dialog box for a Day Event (see previous page).
EDITING MULTIPLE ENTRIES

When you open a recurring Entry that you own, you will be asked whether you want to edit only that specific instance or if you want to edit multiple instances of the Entry. Selecting “Edit this instance only” opens the regular Edit Entry dialog box for the selected recurrence of the Entry. Selecting “Edit multiple instances” opens the Multiple Entry Edit dialog box, in which you can make changes to more than one instance of the same event at once.

RECURRING AGENDA ENTRIES

The Multiple Entry Edit dialog box contains a list of all the recurrences of the Agenda Entry. By selecting the recurrences that you want to edit, you can modify as many instances of the recurring Entry as you like.

Using the Selection buttons at the bottom of the dialog box, select the instances you want to edit using the Edit buttons on the right. You can select several consecutive dates by holding down the Shift key and clicking the first and the last of the dates that you want to edit. To select several non-consecutive dates, hold down the Ctrl key when you click them.

Using the Edit buttons on the right in the dialog box, you can change the title, location, dates, and times for the selected recurrences of your Agenda Entry. You can also add or delete people and resources from the Entry, delete dates, and change your Reminder settings and your reply to the Agenda Entry. You may also view a recurrence of the Entry if you want more detailed information about it. When you have entered all your changes, click OK to implement them.

RECURRING DAY EVENTS AND NOTES

When you open the Multiple Entry Edit dialog box for a recurring Day Event or Daily Note, it will be almost identical to the one for recurring Agenda Entries. You select the instances that you want to edit in the same way. You can make changes to the title, attendees, and reminders, as well as delete one or more instances of the Entry.
**TASKS**

You can keep track of your Tasks by entering them in your Agenda. Your Tasks can be anything from major projects that stretch over a long time, to little assignments you need to do in some specific context. The Tasks can either be linked to an Agenda Entry or be independent. In either case, they are displayed in the Task View of your Agenda’s Daily page and in the Task Display.

**CREATING TASKS**

The New Task dialog box allows you to add Tasks to your Agenda. This dialog box can be opened in a number of ways:

- Choose New Task from the Tasks Menu or the Agenda Menu.
- Click the New Task button on the toolbar (see right).
- Double-click below the existing Tasks in the Task View on your Daily Agenda page or in the Task Display.
- Click New at the bottom of your Task Display.

When you edit or view an Agenda Entry and click New on the Linked Tasks tab dialog box, the Create and Link Task dialog box appears. This dialog box is identical to the New Task dialog box. (See also, Editing Agenda Entries, p. 36).

Furthermore, you can create a New Task with the New edit box at the top of your Task Display (see illustration, p. 25). If you create a Task in this way, you will never get to the New Task dialog box, the Task is instead added directly to the list of Tasks below.

When you create a Task with the New Task dialog box, do not click OK until you have finished with all the tabs of the dialog box. The General tab lets you enter the basic information about your Task. The Task can have, but does not require, a Due date and Due time, a Start date and a Start time. On the General tab you enter the following:

- a Description of your Task
- a Start date and Start time
- a Due date and Due time
- a Priority
- an Access level

**ACCESS LEVEL**

This controls who can access an Entry’s information. There are four levels of access: Normal, Confidential, Personal, and Public. You can set other users’ access rights to Entries of each level in the Access Rights dialog box.
You can set Reminders for both the Start time and the Due time of your Task, using the Reminders tab of the dialog box. Set the Reminders by selecting the “On” checkbox and then entering when and how you wish to be reminded.

The Details tab provides space for comments about the new Task. Your comments can be up to 32,000K long. You can either type directly into the edit box or use the cut (Ctrl-X), copy (Ctrl-C) and paste (Ctrl-V) commands to insert material from elsewhere. You can also attach an entire file to the Task using this tab, in the same way as you attach a file to an Agenda Entry (see p. 34).

**EDITING TASKS**

To edit a Task on your Daily Agenda page, you can do one of the following:

- double-click it in the Task View
- select it on the page and choose Open Entry from the Agenda Menu.

To edit a Task in your Task Display you can any of the following:

- double-click it
- select it and click **Edit** at the bottom of the Display
- select it and choose Edit Selected Task from the Tasks Menu.

The Edit Task dialog box that appears functions in exactly the same way as the New Task dialog box (see above).

**VIEWING TASKS**

The View Task dialog box appears when you open a Task from within the Pop-up Reminder dialog box. It displays information about the Task of which you are being reminded. It also appears when you double-click a Task while viewing the Task Display of another user.

At the top of the dialog box, the Description of the Task is displayed, as well as the date it was created. The View Task dialog box has three tabs: General, Reminders, and Details. When you open a Task from a Pop-up Reminder, you can change your Reminder settings. If you open a Task while viewing someone else’s Task Display, however, there is no Reminders tab in the dialog box.
HOLIDAYS

You can enter Holidays into the database only if your system administrator has given you the authorization to do so. If that is the case, you can open the Holidays dialog box by choosing Holidays from the Directory Menu. It contains a list of all Holidays currently in the system. You add Holidays with the edit box and date box at the top. Once you click the Checkmark button your new Holiday will be included on the list (the ‘X’ button will cancel the addition and clear the edit box).

You cannot edit Holidays. In order to modify a Holiday already entered into the system, you must instead delete it and create a new, modified version of the same Holiday.

On your Daily and Weekly Agenda pages, Holidays are displayed in the Notes View. They appear next to the date on the Monthly Agenda page. Holidays entered by others appear in the New Entries folder of your In-tray. The icon shown to the right indicates a Holiday.

If you double-click a Holiday on an Agenda pages or in your In-tray, the View Entry dialog box appears. The General tab of the dialog box contains the title, date, and Access level of the Holiday. You can set Reminders for the Holiday on the Reminders tab, and you can decide whether or not to keep it in your Agenda on the Agenda tab.

TIME SELECTION

The Time Control is one way of setting the time in many of your Agenda’s dialog boxes. You access it by clicking the Clock button (see right).

You can set the time with the Time Control in three different ways:

- Click the left or right arrow button until the blue arrow is aligned with the desired time. The Time Control is set to move in one-hour intervals when you click the arrow buttons.

- Click the blue arrow and drag it until it points at the desired time. When you choose to do this, the Time Control moves in 15-minute intervals.

- If the desired time is visible in the Time Control, you can simply click it directly on the Time scale to select it.
The time you have selected will be displayed in the corresponding time box. When you have set the correct time, click **OK**.

## THE CALENDAR

The Calendar lets you select a specific date in many of the Agenda’s dialog boxes and date control bars. Access it by clicking the Calendar button (see left).

The five buttons along the upper edge of the calendar allow you to move forwards and backwards months and years at a time. The double arrow buttons take you forwards or backwards one year at a time. The single arrow buttons take you forwards or backwards one month at a time. Clicking **Today** always takes you back to the current date. You can also use the pull-down menus to select the month and year. To select a date you simply click it on the Calendar.
REMINDERS

ENTRY
Anything that appears in the In-tray or on your Agenda pages (Agenda Entries, Tasks, Daily Notes, Holidays, and Day Events)

You can set Reminders for your Entries when you create, edit, or view them using the Reminders tabs of the different dialog boxes.

Default Reminders are the settings the Agenda uses unless you change them when you create or edit an Entry. To set your default Reminder preferences, choose Entry Defaults from the Options Menu. You can set default Reminders for Agenda Entries, Tasks, Day Events, and Daily Notes. For all types of Entries that you receive from other users, however, the default Reminders are the ones you set for Agenda Entries. There are no default Reminders for Holidays, but you can set Reminders for individual Holidays when you view them.

There are two kinds of Reminders: Pop-up windows and Upcoming notes.

UPCOMING NOTES

If you choose an Upcoming note, a Reminder appears in the Notes View of your Daily and Weekly Agenda pages, marked with one of the icons shown to the left. It can be set to appear in your Agenda days, weeks, months, or even years in advance. Clicking the Upcoming note on your Agenda page will open the corresponding Entry, so that you can view or edit it.

POPOP-UP WINDOWS

If you choose a Pop-up window, a dialog box appears on your screen reminding you of your Entry. You can set how much notice you would like by setting the Pop-up Reminder to appear minutes, hours, days, weeks, months, or years in advance.

The Pop-up Reminder dialog box contains all the Pop-up Reminders active at a given time. Each Reminder informs you about its respective Entry. To flip through the Reminders, click the Next Reminder button (see left). Click Snooze to temporarily turn off the Pop-up Reminders. Clicking Clear permanently turns off the Reminder you are viewing; Clear All permanently turns off all of the Reminders contained in the Pop-up Reminder dialog box. Click Open to view detailed information about the Entry (you cannot edit it here, even if you own it). Clicking Reminder takes you to the Reminders tab for that Entry and let you reset its Reminder.
LISTS AND GROUPS

CREATING LISTS

Whenever you need to add people, groups, or resources to a list (for instance, when you are inviting people and resources to an Entry or creating a group), you will see the edit box shown to the left.

ADDING PEOPLE

To add a person to the list you are creating, type the person’s name in the edit box. If you do not know the name, but you do have other information (such as an organization unit or part of the name), you can click the Search button to open the Search dialog box. (See also, Searching, p. 55.)

If a person’s name has a blank character in it, either in their first name (for example, “Mary Jane”) or in their surname (for example, “von Hof”), you must type in a ^ character (Shift + 6) instead of the blank space when you enter that person’s name. Otherwise your Agenda will not understand which name is which. For example:

- Write “Mary^Jane Johnson”, instead of “Mary Jane Johnson”;
- Write “Peter von^Hof”, instead of “Peter von Hof”.

If you enter organization units with the user’s name, the organization units must be separated from the name, and from each other, by slashes. For example:

Jay Ford/CORP/MKTG/EXT; or
Jay Ford/OU1=CORP/OU2=MKTG/OU3=EXT.

If you do not include the “OU# =”, then the organization units must be entered in their correct sequence. If you enter:

Jay Ford/EXT

your Agenda will assume EXT is the first organization unit. However, if you enter:

Jay Ford/ // EXT

your Agenda will understand that EXT is the third organization unit. The spaces provided by the other two slashes insert two empty organization units.
If your Agenda cannot find a unique name with the search parameters you have entered, a dialog box containing a list of possible names appears. Select the correct name from this list and click OK. The selected name will be entered in the Add edit box.

Once the name, or part of the name (and any possible organization units you’ve included) is in the edit box, you can click the Checkmark to accept the addition to the list. This adds the person to the list of people and resources you are creating. To cancel the addition, click the “X”. This erases the person’s name from the edit box. They are not added to the list.

**ADDING RESOURCES**

To add a resource to the list, type “r:”, “re:”, or “res:” followed by the resource’s name. If you do not know the resource’s name, but you do have other information (such as part of the name), you can click the Search button to open the Search dialog box.

You can also enter the resource’s number, with or without its name. The number must be separated from the resource name by a slash. For example:

r:Meeting Room/R3535-1

If you wish to enter only the resource number, without the resource name, it must be preceded by a slash. For example:

r:/R3535-1

Once the resource’s name is in the edit box, click the Checkmark to accept the addition. This adds the resource to the list of people and resources you are creating. To cancel the addition, click the “X”. This erases the resource’s name from the edit box. It is not added to the list.

**ADDING GROUPS**

To add a group to the list you are creating, type “g:”, “gr:”, or “grp:” followed by the group’s name. Once the name is in the edit box, click the Checkmark to accept the addition. This adds all the group’s members to the list of people and resources you are creating. To cancel the addition, click the “X”. This erases the group’s name from the edit box. The group members are not added to the list.

You can also click the Group button (see left) to select a group you wish to add to your list. This opens the
Select a Group dialog box, which displays the groups available to you by type (Public, Private, Members Only or All) along with a list of their members. You have the option to print both a list of all the available groups and a list of the selected group’s members.

To add a group to your list, select the group from the Groups Available list box and click OK. This adds the names of all the group’s members directly to the list you are creating. (The group’s name will not appear in the edit box first.)

Furthermore, you can click the Search button to open the Directory Search dialog box. Go to the Groups tab of that dialog box to search for and select the group(s) you wish to include on your list (see Searching, p. 55).

**MANAGING GROUPS**

You can create groups of people and resources in your Agenda, allowing you to schedule entries with a number of people and resources quickly and easily. To access the Group Management feature, select Manage Groups from the Directory Menu.

There are four different group types available:

- **Public groups** are available for use to everyone on the system. However, they can only be modified by the group’s owner.

- **Private groups** are only available for use by their creators.

- **Administrative groups** are for use by everyone on the system. However, they can only be modified by those users with Administration Group rights (this is controlled by the system administrator.)

- **Members Only groups** are available for use only by the members of the group.

Administrative groups can only be created by users who have been granted special rights by the system administrator. Which users have the right to create Public groups depends on the way your system has been set up, but any user can always create Private or Members Only groups. You create groups using the Group Management dialog box. In this dialog box, you can also modify groups you have created.
**Creating Groups**

You create groups of people and resources within your Agenda using the Group Management dialog box. Enter a name for the group in the edit box on the left-hand side and select a group type from the list of options available in the field to the right. The group type controls which users can use your group (see previous page). Once you have accepted the new group by clicking the Checkmark button, its name will appear on the list of groups available in the list box below, preceded by an abbreviation indicating what type of group it is.

Add members to the group using the edit box on the right-hand side. Enter the name of each person or resource you wish to include in your group and click the Checkmark to accept the name. Clicking the “X” erases the current name from the edit box, but has no effect on the list of group members that you have already accepted. (See also, Creating Lists, p. 49.) If you need to search for people or resources you want to include in your group, click the Search button to open the Search dialog box (see Searching, p. 55).

You can print a list of the groups that exist on your system by clicking the **Print Groups** button. The print-out will list all groups, with a list of each group’s members (up to a maximum of 50 members). To print a list of the members of a specific group, select the group and click the **Print Members** button. The print-out will list all the group members.

**Modifying an Existing Group**

You can also modify existing groups in your Agenda using the Group Management dialog box. Select the group you want to modify in the list box on the left-hand side. The group is then entered in the Modify selected group edit box, where you can make changes to its name and group type. Click the Checkmark button to accept the changes you have made to the group.

To add members to an existing group, you must first select the group from the list box on the left-hand side of the Group Management dialog box. Then add members to the group in the same way as when you create a group (see above). As long as the group is selected in the left-hand list box, all its members are listed in the right-hand list box.

To delete members from an existing group, select the group from the left-hand list box. In the list of mem-
bers, select the name of the person or resource you want to delete from the group. Click **Delete Member** to remove that person or resource from the group.

**DELETING A GROUP**

To delete a group, select the group from the list in the left-hand list box. Click **Delete Group** to permanently delete that group.
SEARCHING

You can access the Directory Search dialog box from any dialog box where you need to enter names of people, resources, or groups, by clicking the Search button (see left). It will also appear if you select Search Directory from the Directory Menu.

The Directory Search dialog box will look and function differently depending on which kind of search you are doing. There are three different kinds of searches: Single User Selection, Multiple User Selection, and Directory Searches.

SINGLE USER SELECTION SEARCHES

When you click the Search button in a dialog box where you can only select one person or resource, the Single User Selection version of the Search dialog box appears. (This is the case, for example, when you want to search for a user name in the Open an Agenda dialog box.)

PEOPLE

To search for and select a person, use the People tab of the dialog box. Type the first few letters of the person’s surname or any other search parameter (such as an organization unit or domain) in the appropriate edit box and click Search. If you do not type in a search parameter, your Agenda may give you the entire directory list. On some systems, however, you could get the message, “Surname string too short,” in which case you need to enter a few letters to start your search.

The result of your search is listed in the Found list box at the bottom of the dialog box. If your Agenda finds more than one hundred people, only a hundred names will be listed at a time. Use the scroll buttons on either side of Search to view each segment of the list. Those users appearing in the list with an (F) next to their name are foreign users. The users with an (R) or other notes in brackets next to their name are remote users.

You can print the entire list of users found by clicking Print. To find out more about a person, highlight the person’s name in the list box and click Information. This opens a pop-up box containing the information available about the person. Once you have read the information, click OK to dismiss the dialog box.
When you have decided on which user to select, highlight the user’s name in the Found list box and click OK in the Search dialog box.

**RESOURCES**

To search for and select a resource, use the Resources tab of the dialog box. Type the first few letters of the resource’s name or its number as the search parameter. If you do not enter a search parameter, your Agenda will list all available resources. Select the “Local resources only” checkbox to exclude remote resources (i.e. resources on a different server).

Click Search. The result of your search is listed in the Found list box, where you can get information about the resources found, print the list of resources, and select a resource in the same way as when you search for people (see the previous section).

**GROUPS**

To search for groups and select a member of a group, use the Groups tab of the Directory Search dialog box. Choose the group types you want to display by selecting the appropriate checkboxes. Selecting the “Private” checkbox will display the private groups you have created. Selecting the “Others” checkbox will display all other groups you are permitted to see, including any Members Only groups you may be part of. Select the group types you would like displayed and click Search.

The groups available are displayed in the upper list box. Select a group from this list box. Its members are displayed in the Members list box below. Those users appearing with an (F) next to their name are foreign users. The users with an (R) or other notes in brackets next to their name are remote users. Click Print to print a list of the selected group’s members. To find out more about a group member, highlight the name of the person or resource in the list box and click Information.

When you have decided which group member to select, highlight the name of the person or resource in the Members list box and click OK.

**GROUP TYPES**

There are four group types: Public, Private, Administrative and Members Only. Not all types will be available in every case or to every user.
When you click the Search button in a dialog box where you can select several people or resources, the Multiple User Selection version of the Search dialog box appears. (This is the case when you are working on a list of people and resources, which can be found in many dialog boxes.) The People, Resources, and Groups tabs of this version of the dialog box look and function in the same way as in the Single User Selection version of the dialog box (see Single User Selection Searches, above). However, you can select several people and resources from searches done with one or more tabs.

The bottom part of the dialog box lets you select people and resources from your searches. The result of each search is listed in the left-hand list box. Those users appearing with an (F) next to their name are foreign users. The users with an (R) or other notes in brackets next to their name are remote users. The users with an (R) or other notes in brackets next to their name are remote users.

The center buttons let you create a list of selected people and resources in the right-hand list box. Highlight the names of the people and resources that you want to select in the left-hand list box and click Add to add them to the right-hand list. To highlight a number of consecutive names, hold down the Shift key and click the first and the last of the names. To highlight a number of non-consecutive names, hold down the Ctrl key as you click each name. If you wish to select all the names listed in the left-hand box, click Add all. Once you have finished selecting people and resources from searches done with one tab, you can go to the next tab to continue your search. The names in the Selected list box will remain.

To remove a person or resource you have included on the list, highlight the name in the Selected list box and click Remove. Just as in the Single User Selection version of the dialog box, you can open a pop-up box containing the system’s information about a person or resource by highlighting the name and clicking Information. You can also print a list of the people and resources that you have selected by clicking Print.

Once you have finished searching and selecting and all the people and resources that you want to select are listed in the Selected list box, click OK. The selected people and resources are automatically included on the list you were working on when you opened the Search dialog box.
DIRECTORY SEARCHES

The version of the Search dialog box that lets you do Directory Searches is called up when you choose Search Directory from the Directory Menu. In this version of the dialog box you cannot select the names of people and resources to enter them in a list or an edit box. The Search Directory command simply gives you quick access to the System Directory, so that you can inform yourself about the people, resources and groups on your system.

Apart from the fact that you cannot select a person or resource from the Found list box, this version of the dialog box looks and functions in the same way as the Single User Selection version of the dialog box (see p. 55). You can print the result of your search by clicking Print, and call up a pop-up box containing the system’s information about a person or resource by highlighting the name and clicking Information. Once you’ve finished your Directory Search, click Done to dismiss the dialog box.

WHERE IS...

The Where is...? dialog box (Directory Menu, Where is Person) allows you to find out what people, resources or groups have scheduled in their Agendas at a specific time. To do this, specify the date and time in the date and time boxes, and enter the name of the person, resource, or group in the edit box. (Precede the name of resources with “r:”, “re:”, or “res:” and group names with “g:”, “gr:”, or “grp:”.) Click the Checkmark to submit your search. Clicking the ‘X’ erases the name entered in the edit box and cancel the search.

The information found is displayed in the list box below. The information displayed depends on the Access rights you have been granted in that user’s Agenda (see Access Rights, p. 59). If you have the right to see all the information about the Agenda Entry, both the title and the location are displayed. If you only have the right to see the busy times of the Agenda Entry, your search can only indicate that the user is busy at that time. If you have no viewing rights for the Agenda Entry, no information will appear. If your Agenda does not find any information based on your search parameters and viewing rights, it will indicate this in the list box.
ACCESS RIGHTS

Use the Access Rights dialog box (Options Menu, Access Rights) to give designate rights to others, and decide which Entries other users can view in your Agenda (for example, when they are working with a Group Agenda). You can also block other users from inviting you to Entries. Furthermore, you choose default settings for Access rights in your Agenda in this dialog box.

GENERAL

The Access Rights dialog box has four tabs where you grant other users designate, viewing, and scheduling rights in your Agenda, as well as choose the default settings for other users. To set the default Access rights in your Agenda, select “Default: Any unlisted person” in the list box and choose the settings in the same way you would for an individual user (see specific instructions for each tab below). These default settings apply to anyone who has not been included on the list of users with special access rights.

To grant a user special rights on any of the four tabs, you must enter their name in the list box at the bottom of the dialog box. To do this, type the name of the user in the edit box and add it to the list box by clicking the Checkmark (the ‘X’ will cancel the addition). If you need to search for a user’s name, click the Search button (see left) to open the Search dialog box (see Single User Selection Searches — People, p. 55).

Once the name is in the list box, you can select it and grant the user special Access rights on one, some, or all of the different tabs of the dialog box. On tabs where you do not want to give the person any special rights, you can quickly set their rights to be the same as the default by selecting the Same as Default checkbox.

To delete a name from the list of users with special Access rights, select the name from the list box and click Delete. They will then revert to the same rights as the default on all the tabs of the dialog box.

Click OK once you have finished with all the tabs of the dialog box.
DESIGNATE RIGHTS

Use the Designate tab of the dialog box to grant the selected user the right to act as a designate in your Agenda. Remote users cannot act as designates.

Use the checkboxes to choose what rights you want to give the designate to your Agenda Entries, Day Events, and Daily Notes for each Access level. You can choose one of three options for each Access level:

- **Modify**: The designate will have the right to modify your Entries.
- **View/Reply**: The designate will have the right to view your Entries completely, as well as the right to reply to invitations in your name.
- **View times only**: The designate will only have the right to view the times for which you have scheduled Agenda Entries (if you choose this option, the designate will not see Daily Notes or Day Events with this Access level in your Agenda, since they have no time).

If you leave all the checkboxes cleared for an Access level, the designate will have no rights for Entries with that level. (They will not see Agenda Entries, Day Events, or Daily Notes with this access level in your Agenda.)

You can assign different rights to different types of Agenda Entries, Day Events, and Daily Notes, according to the Access level you have assigned your Entries.

- **Normal Entries**: If you select one of these checkboxes, the designate can view or edit Agenda Entries, Day Events, and Daily Notes with "Normal" access.
- **Confidential Entries**: If you select one of these checkboxes, the designate can view or edit Agenda Entries, Day Events, and Daily Notes with "Confidential" access.
- **Personal Entries**: If you select one of these checkboxes, the designate can view or edit Agenda Entries, Day Events, and Daily Notes with "Personal" access.
- **Public Entries**: If you select this checkbox, the designate can edit Agenda Entries, Day Events, and Daily Notes with "Public" access. (You cannot block a designate from viewing Public Entries.)
Note that you must grant a user the right to modify Agenda Entries, Day Events, and Daily Notes for at least one Access level in order to grant them the right to open your Agenda as a designate. That is, users must have the right to edit some kind of Agenda Entries, Day Events, and Daily Notes in order to work as a designate on your Agenda pages.

The checkboxes to the right concern designate rights to your Tasks. For Tasks, you can only choose between granting full designate rights (that is, the right to view and modify) or no designate rights at all for each Access level.

- **Normal Tasks**: If you select this checkbox, the designate can view and edit those Tasks with "Normal" access.
- **Confidential Tasks**: If you select this checkbox, the designate can view and edit those Tasks with "Confidential" access.
- **Personal Tasks**: If you select this checkbox, the designate can view and edit those Tasks with "Personal" access.
- **Public Tasks**: If you select this checkbox, the designate can view and edit those Tasks with "Public" access.

Instead of setting designate rights for each type of Entry individually, you can also choose to grant the user:

- **Full Designate Rights**: the designate can view and modify all Entries.
- **No Designate Rights**: the person has no rights as a designate in your Agenda.

It is not recommended for users to give designate rights to every user on the system. Furthermore, the names of those users who do give such rights to all users will not appear on everyone’s list of possible designates in the Open Agenda dialog box (see Opening Agendas, p. 3). Therefore, you should set the default to “No Designate Rights”.

**VIEWING RIGHTS**

Use the Viewing tab of the dialog box to control how much information the selected user will have the right to view about Agenda Entries, Day Events, and Daily Notes in your Agenda. These rights are applied when the user opens your Agenda to view it (see Opening Agendas, p. 3).
Use the checkboxes to choose what viewing rights you want to give the user. You set the rights for Normal, Confidential, and Personal Access levels (you cannot block another user from viewing Public Entries) separately. You have three options for each Access level: you can grant your user the right to see either only the blocks of busy time (Busy time); all information about the Entries (Details); or, you can block the user completely from seeing the Entries (by leaving the checkboxes unselected). Note that if you give the right to only view busy times, the user cannot view Day Events or Daily Notes with that Access level in your Agenda, since these Entries have no time.

Instead of setting viewing rights for Entries with different Access levels individually, you can also choose to grant the user:

- **Full Viewing Rights**: the user can view all Agenda Entries, Day Events, and Daily Notes.

- **No Viewing Rights**: The user can only view Public Agenda Entries, Day Events, and Daily Notes in your Agenda. (Public Entries can always be viewed by all users.)

### TASK VIEWING RIGHTS

Use the Tasks tab of the dialog box to grant the selected user Task viewing rights controlling what Tasks the user can view in your Agenda. These rights apply when the user opens your Agenda pages or Task Display to view them (see Opening Agendas, p. 3 and Opening a Task Display, p. 25).

Use the checkboxes on the Task tab to choose what Task viewing rights you want to give the user. You set the rights for Normal, Confidential and Personal access levels (you cannot block another user from viewing Public Tasks) separately. If you grant users the right to view Tasks, they can see all the information about those Tasks.

Instead of setting the rights for each type of Task individually, you can also choose:

- **Full Viewing Rights**: The user can view all Tasks.

- **No Viewing Rights**: The user can only view Public Tasks in your Agenda. (Public Entries can always be viewed by all users.)
SCHEDULING RIGHTS

The Scheduling tab of the Access Rights dialog box lets you control the selected user’s right to invite you to events.

- Select “Can invite me to events” to grant the user the right to schedule Entries with you.
- Deselect “Can invite me to events” to withdraw scheduling privileges from the user.
SETTING PREFERENCES

You can personalize your Agenda by setting your own preferences for many of its functions.

It is important to remember that changes you make to some preferences will not apply until you have closed and reopened the window in which these preferences apply.

SCHEDULING PREFERENCES

Your Scheduling preferences are only used by the Suggest Another Date or Time feature to limit its searches. You can set up your preferences by choosing Scheduling from the Options Menu. (See Suggest Another Date or Time, p. 36.)

The Scheduling Preferences dialog box contains a tab for each day of the week, but you can set the preferences on one tab and click Apply to All to set the same scheduling preferences for each day of the week.

Your normal hours are the hours during which you usually work and schedule Agenda Entries. For example, if you work from 9:00 AM to 5:00 PM or 8:00 AM to 4:30 PM these would be your normal hours.

Your extended hours are the outside limits for scheduling Agenda Entries in your Agenda. For example, you may usually work from 9:00 AM to 5:00 PM, but you might be willing to schedule a meeting or other event as early as 8:00 AM or as late as 6:00 PM. In that case, 8:00 AM to 6:00 PM would be your extended hours.

COLOR CODING

Color coding your Agenda Entries gives you a clearer picture of your Agenda, even at a quick glance. Your Agenda Entries can be color coded in one of three ways:

- **by Importance level:** indicates the level of Importance that was assigned to the Agenda Entry when it was created (or edited most recently);
- **by Attendance status:** indicates whether you plan to attend the Agenda Entry, and whether it is a tentative Entry;
- **by Ownership:** indicates whether you or somebody else own the Agenda Entry, and whether it is a tentative Entry.
To change the color code for your Agenda Entries, go to the Display tab of the Agenda Preferences dialog box (Options Menu, Agenda—see Agenda Preferences, p. 71), or click the Colors button in the Daily, Weekly, or Group Agenda Pages (see right). Select your preferred color scheme from the pull-down menu.

**NOTE:** When you color code your Agenda Entries by ownership and you open another user’s Agenda, the Agenda Entries you own (not the Agenda’s owner), will appear in blue. This makes it easier to spot Agenda Entries you can edit in other users’ Agendas. (Even if you are in another user’s Agenda, you can edit an Entry you own.) However, if you are working in someone else’s Agenda as a designate, the Agenda owner’s Agenda Entries appear in blue, since you are working in that person’s Agenda as though you were its owner.

### GENERAL PREFERENCES

**NAME FORMATS**

You choose your name and resource formats using the Names tab of the General Preferences dialog box (Options Menu, General). Enter your preferred name format by selecting one of the formats offered. Select the Generation box to include any generational suffix when displaying names in your Agenda (for example, “John Smith III”).

Select how you want your Organization units and other organizational information displayed. You can choose to separate items from the name and each other by slashes, without codes for what they indicate; or the items can include codes for what they indicate (i.e. OU# = for Organization units, C= for Country, A= for Administrative Domain, etc.). Select which Organization units and what other information (Organization, Country, and Domains) you want to appear next to the name. Check the appropriate boxes.

You can set your preferred format for resource names as well. Choose one of the three formats offered in the dialog box.

**NOTE:** When working in a dialog box where you set your preferences, click OK only when you’ve finished with all the tabs of the dialog box.
DATE AND TIME FORMATS

The Agenda uses your preferred date and time formats in its displays. To set up these preferences, use the Date and Time tab of the General Preferences dialog box (Options Menu, General).

Enter your long and short date format preferences by selecting from the options available. You can type the character of your choice as a separator for the short date format.

Times can be displayed on your Agenda pages and elsewhere using either the AM/PM format or the 24-hour format. Select your preferred option.

MAIL CLIENT

See All about the Mail, p. 87.

TIME ZONES

Your Agenda can change time zones to accommodate any travel or long-distance scheduling you may require. To do this, use the Time Zones tab of the General Preferences dialog box (Options Menu, General).

There are two ways to select the time zone you wish to use:

- If you know the name of the time zone you wish to use, enter it in the top edit box, or select it from the list available by clicking the arrow to the right of the edit box.

- If you do not know the name of the time zone, you can select the name of the region or country whose time zone you wish to use. Click Load Regions. The Agenda will display a list of countries and regions in the Regions list box. Select the desired region or country and its time zone is entered into the upper edit box.

Provided you change time zone for this session only (see below), you can return to your normal time zone without logging out. To do this after working in the temporary time zone, open this dialog box again and click Revert to host's time zone.

Changing Your Default Time Zone

The System Operator can give the system’s users the right to change time zone for future sessions. This can
be useful for someone who frequently travels between time zones.

If you do not have this option, the text “Save time zone change for future sessions” will be dimmed (inactive) (you cannot select this button). If you have the option of changing your default time zone but do not wish to use it, select “Make time zone change for this session only”.

To change your default time zone, select “Save time zone change for future sessions”. In the future, you will always sign in to the changed time zone. If you wish to temporarily use the host’s time zone again, you must open this dialog box and click Revert to host’s time zone. To then return to your new default time zone without logging out, click Restore saved time zone.

OFF-LINE PREFERENCES

You can work in your Agenda on-line or off-line. Before using your Agenda off-line you must configure your Off-line Agenda. You can do this either when signing in off-line for the first time (see Signing in Off-line, p. 1), or while working in your Agenda on-line. To do the latter, choose Off-line from the Options Menu.

OFF-LINE LOCATION

To open your Agenda off-line, you must first specify the off-line directory in which your local database will be kept. If you are unsure of the exact directory name where you want to store the Off-line Agenda file, click Browse to look for it. Select “Create directory if none exists” if you want to place your downloaded file in a new directory.

OFF-LINE ENTRY DOWNLOADING

The Download tab of the Off-line Preferences dialog box lets you select the range of Entries that will be downloaded to your Off-line Agenda.

You can select the period of time for which you want your Entries to be downloaded and choose whether to download your Agenda each time you quit the application. There are three options to choose from:

• **Always download**: your Agenda is automatically downloaded when you quit the On-line Agenda.

• **Prompt before download**: you will be asked whether you want to download to your Off-line
Agenda each time you quit the On-line Agenda.

- Never download: your Agenda is not downloaded unless you choose to do so using the Download to Local File command from the File Menu.

**Off-line People/Resources Downloading**

The People/Resources tab of the dialog box lets you choose which other users’ Agendas will be included when you download your Off-line Agenda.

Using the edit box at the top of the tab, create a list of the users whose Agendas you want included in your Off-line Agenda (see Creating Lists, p. 49). The Agendas of these users will always be downloaded with your Agenda.

When you open the downloaded Agendas of other users while working off-line, you will only be able to view those Entries to which you have been given viewing rights (see Access Rights, p. 59).

**Off-line Group Downloading**

You may want to download certain groups of people and resources to your Off-line Agenda. To do so, use the Groups tab of the Off-line Preferences dialog box. Choose the groups to be included in your downloaded Agenda.

- If you do not want to include any groups, select “No Groups”.

- If you wish to download all groups with your Agenda, select “All Groups”.

- If you wish to select only certain groups, click the button next to “Select Groups”. Then decide what types of groups you wish to choose from: Private, Public (that is, all the other group types), or both. Select the appropriate checkboxes and click Load. Your Agenda then displays a list of the available groups. To delete a Group from the list displayed, select the Group and click Delete. The group is removed from your list.

**NOTE:** When you download a group, you are downloading the list of people and resources, not the Agendas of all the group’s members. To download the Agendas of the group’s members, use the People/Resources tab of this dialog box.
**OFF-LINE RECONCILIATION PREFERENCES**

This tab of the Off-line Preferences dialog box allows you to automate the way your Off-line Agenda is uploaded to your On-line Agenda. You can choose to make decisions on a case-by-case basis, or let your Agenda automatically handle certain situations. Set your preferences in each section.

When an Entry has been deleted in the Off-line Agenda but still exists in the On-line Agenda, the Agenda can:

- **Show the Reconciliation dialog box** — you review the deletion and decide whether to make it in your On-line Agenda.
- **Delete the Host Agenda Entry** — the Agenda automatically removes the Entry from your On-line Agenda.

When an Entry has been modified in both the Off-line and the On-line Agenda, the Agenda can:

- **Show the Reconciliation dialog box** — you review and compare the changes before deciding which modification to keep in your On-line Agenda.
- **Update the Host Agenda Entry** — the Agenda is automatically updated the Entry in your On-line Agenda.

If Agenda Entries are created or modified both in the On-line and Off-line Agenda, scheduling conflicts can arise when you upload. The Agenda can:

- **Check for conflicts on upload** — when a conflict arises between off-line and on-line Agenda Entries when uploading, the Agenda displays information about the conflict and lets you decide what should be done about it in the Conflicts Detected dialog box.
- **Ignore conflicts on upload** — the Agenda does not prompt you about such conflicts when uploading.

Select the “Redownload Host Agenda after upload” checkbox if you want the reconciled Host Agenda to be downloaded automatically after each upload. This option ensures that the Off-line Agenda and On-line Agenda are identical after every upload. If you do not select this option, the two Agendas may differ.

**NOTE:** When working in a dialog box where you set your preferences, click OK only when you’ve finished with all the tabs of the dialog box.

---

Reconciliation is the process in which you make two versions of the Agenda consistent with one another, through reconciling the Entries that cause inconsistencies (i.e., you decide which version of the Entry you want to keep). You may need to go through a reconciliation process when you upload your Off-line Agenda to your On-line Agenda, and when you import from or export to your palmtop.
AGENDA PREFERENCES

AGENDA PREFERENCES — DISPLAY

You can set up how your Agenda pages will be displayed using the Display tab of the Agenda Preferences dialog box (Options Menu, Agenda).

Choose the times at which you want your day to begin and end. This forms the central block of time in your Day and Week Views. You can enter the times using either the arrows to the right of the boxes or by clicking the clock button (see Time Selection, p. 44). In the Interval box, you set up the interval you want each time slot in your Agenda’s Day View to represent. You can also choose between the AM/PM and 24-hour time formats, if you have not already done so in the General Preferences dialog box.

Set up your week by choosing the day on which you want your week to begin, and whether your week should include Saturdays and Sundays.

Choose your preferred color coding scheme. Your Agenda Entries can be color coded according to Importance level, Attendance Status, or Ownership. To view the options, click the arrow to the right of the box. Select one. (See also, Color Coding, p. 65).

Finally, select display options for your Agenda Entries. There are five options that affect the way Agenda Entries are displayed and which Agenda Entries you will see in your Agenda. Select the checkboxes for those options you want your Agenda to display.

AGENDA PREFERENCES — NOTIFICATION

You can set up the Notification function of your Agenda using the Notification tab of the Agenda Preferences dialog box (Options Menu, Agenda). This function will let other users notify you by e-mail when they create Entries you are invited to. It also controls the refresh rate for your Agenda.

- To receive e-mail messages from other users about new Entries you have been invited to, select “Receive notification of new Entries by e-mail”.

- To have your Agenda check for new Entries at regular intervals, select “Check for new Entries every...”. Type in the interval you want in the box below the checkbox. It will then refresh...
your Agenda, In-tray, and Task Display at this interval (minimum 15 minutes).

You can also choose in which cases your Agenda asks whether you want to send an e-mail message to other users. There are three choices available, from which you can select some, all, or none.

- **Mail to attendees on Entry creation:** Asks whether you want to send an e-mail message every time you invite other users to an Entry you are creating.

- **Mail to attendees on Entry modification:** Asks whether you want to send an e-mail message every time you modify an Entry to which you have invited other users.

- **Mail to attendees on Entry deletion:** Asks whether you want to send an e-mail message every time you delete an Entry to which you have invited other users.

**IN-TRAY PREFERENCES**

The In-tray Preferences dialog box (Options Menu, In-tray) lets you control how you can manage your Entries in the In-tray, and for which periods you will see Entries in the different In-tray folders.

**NEW ENTRIES**

By double-clicking an Entry in the New Entries folder you can either reply to the Entry or view it.

- “Fast reply to the Entry” lets you reply to the Entries you receive without viewing them first.

- “View the Entry” lets you view all the information about the Entries you receive before responding.

**ACCEPTED ENTRIES**

You can access and view the Entries you have accepted in different ways. By double-clicking an Entry in the Entries you’ve accepted folder you can either change your reply to the Entry or view it.

- “Fast Reply to the Entry” lets you change your reply without first viewing the Entry.

- “View the Entry” lets you view all the information about the Entry.
You can also choose to see either all future Entries you have accepted, or limit the display in the In-tray to only a specific range. Select the option you prefer. If you choose to see only a limited range of Entries, enter the interval for which you would like your Entries displayed.

**ENTRIES SENT**

In the Entries you’ve sent out folder, you can either choose to see all future Entries you have sent out, or limit the display in the In-tray to only a specific range. Select the option you prefer on the Sent tab of the dialog box. If you choose to see only a limited range of Entries, enter the interval for which you would like your Entries displayed.

**REFUSED ENTRIES**

You can access and view the Entries you have refused in different ways. By double-clicking an Entry in the Entries you’ve refused folder you can either change your reply to the Entry or view it.

- “Fast Reply to the Entry”: lets you change your reply without first viewing the Entry.
- “View the Entry”: lets you view all the information about the Entry.

You can also choose to see either all future Entries you have refused, or limit the display in the In-tray to only a specific range. Select which option you prefer. If you choose to see only a limited range of Entries, enter the interval for which you would like your Entries displayed.

**ENTRY DEFAULTS**

The Entry Defaults are the preset values or options that appear in the dialog boxes whenever you create an Agenda Entry, Task, Day Event, or Daily Note. You can set the value for any Entry you create yourself. The values assigned here are simply default values that will be used unless you change them.

**AGENDA ENTRY DEFAULTS**

The Agenda Entries tab of the Entry Defaults dialog box lets you choose default settings for new Agenda Entries.

- Choose the default Importance level and Access level settings. Click the arrow on the
right-hand side of the edit box to see the options and choose one for each.

- Set the default Reminders by selecting the “On” or “Off” button. If you select the “On” button, you can set the Reminder type by selecting either Pop-Up Window or Display Upcoming.

- Set when you wish to be reminded. Click the arrow next to the right-hand box to see the options. You can choose to be reminded minutes, hours, days, weeks, months, or even years before an Agenda Entry. Type the appropriate number in the box on the left.

**NOTE:** The Reminder setting you choose here will also be the default for any Entries that you receive from other users.

### Task Defaults

The Tasks tab of the Entry Defaults dialog box lets you choose default settings for new Tasks.

- Choose the default Priority and Access level from the pull-down menu by clicking the arrow on the right-hand side of the edit box to see the options. Choose one for each.

- Choose the default settings for the Task Start and Task Due Reminders. For each Reminder, choose the “On” or “Off” button. If you select the “On” button, you can set the Reminder type by selecting either Pop-Up Window or Display Upcoming.

- Finally, set when you wish to be reminded. Click the arrow next to the right-hand box to see the options for each Reminder. You can choose to be reminded minutes, hours, days, weeks, months, or years before a Task’s Start time or Due time. Type the appropriate number in the box on the left.

### Day Event Defaults

The Day Events tab of the Entry Defaults dialog box lets you choose default settings for the Day Events you create.

- Choose the default Access level. Click the arrow on the right-hand side of the edit box to see the options and choose one.
- Set the default Reminders. Select either the “On” or “Off” button. If you select the “On” button, you can set the Reminder type by selecting either Pop-up Window or Display Upcoming.

- Set when you wish to be reminded. Click the arrow next to the right-hand box to see the options. You can choose to be reminded minutes, hours, days, weeks, months, or years before a Day Event. Type the appropriate number in the box on the left.

**Daily Note Defaults**

The Daily Notes tab of the Entry Defaults dialog box lets you choose default settings for the Daily Notes you create.

- Choose the default Access level. Click the arrow on the right-hand side of the edit box to see the options and choose one.

- Set the default Reminders. Select the “On” or “Off” button. If you select the “On” button, you can set the Reminder type by selecting either Pop-up Window or Display Upcoming.

- Set when you wish to be reminded. Click the arrow next to the right-hand box to see the options. You can choose to be reminded minutes, hours, days, weeks, months, or years before a Daily Note. Type the appropriate number in the box on the left.
PALMTOP PREFERENCES

Before you exchange data between your Agenda and your palmtop, you should set your palmtop reconciliation preferences. Do this using the Palmtop Reconciliation Preferences dialog box, which appears when you choose Palmtop from the Options Menu, or when you click Options in the Palmtop Reconciliation dialog box (see p. 99).

Here you control the way in which your palmtop calendar file and your Agenda are reconciled when you import the palmtop data to your Agenda. You can choose to make decisions on a case-by-case basis, or let your Agenda automatically handle certain situations.

When an Entry has been deleted from the palmtop but is unmodified in your Agenda, you can choose to confirm each Entry reconciliation before it is made or let the Agenda reconcile all such Entries automatically.

- If you select “Confirm before Reconciling”, you can review the Entry that has been deleted in the palmtop and decide whether to delete the Entry from the Agenda.
- If you select “Reconcile Automatically by:”, you must also choose whether your Agenda deletes the Entry from the Agenda or to keep the Entry in the Agenda.

When an Entry has been modified both in the palmtop and in your Agenda, you can similarly choose to confirm each Entry reconciliation before it is made, or let the Agenda reconcile all such Entries automatically.

- If you select “Confirm before Reconciling”, you can review and compare the Palmtop and Agenda versions of the Entry that has been modified, and then decide which version to keep.
- If you select “Reconcile Automatically by:”, you must also choose which of the versions you always want your Agenda to keep, the Palmtop or the Agenda version of the Entry.

If Agenda Entries are created or modified both in the palmtop and in your Agenda, scheduling conflicts can arise when you exchange data between the two. As part of the palmtop reconciliation process, you can have your Agenda prompt you on such conflicts:

- Select “Check for conflicts on import” if you want the Agenda to display information about
scheduling conflicts and let you decide what to do about them in the Conflicts Detected dialog box (see p. 99).

- Select “Ignore conflicts on import” to disregard conflicts when exchanging data with your palmtop.

Click **OK** once you have set all your preferences.
PRINTING

You can print the information contained in your Agenda in a range of different formats. The printing feature lets you print your Agenda pages (Daily, Weekly, and Monthly) as well as your In-tray or your Task Display. You can also print out a Day list, which is a list of the Agenda Entries and (if you wish) other Entries scheduled for each day.

THE PRINT DIALOG BOX

You access the printing feature by choosing Print from the File Menu or by clicking the Print button on the toolbar (see left). This opens the Print dialog box.

If you choose to print while working in your Task Display or In-tray, what you are currently seeing in the Task Display or In-tray is printed out in the layout of your choice. When you open the Print dialog box while working on your Agenda pages, you can choose the types of Agenda pages you want printed, the print layout, and the range of dates for which you want your Agenda pages printed. To print out Group Daily and Group Day List pages, you must choose to print from within a Group Agenda.

The dialog box also gives you access to the Print Setup dialog box—through which you can change the selected printer, the paper size you are using, and the page orientation—and the Print Preview—where you can see what your print-out will look like (see p. 85).

To select the layout you want to use, choose one of the formats available. For each format, you can specify certain options, described below. This allows you to customize the print-outs to suit your needs.

If you are printing your Agenda pages, select the types of Agenda pages you wish to print from the list at the bottom of the dialog box. You can choose to print more than one type of page at the same time. For example, you can print your Day list for the month at the same time as you print your Monthly Agenda page. You do not need to go to the Print dialog box twice.

Then choose the range of dates for which you want to print out your Agenda pages. If you enter dates that fall in the middle of the week and you choose to print your Weekly Agenda pages, the entire weeks in which those dates fall will be printed out. For example, if your Start date is a Wednesday and the End date is the
following Tuesday, two Weekly Agenda pages will be printed out: one for the week containing the Wednesday, and another for the following week, containing the Tuesday. The weekly pages printed out always have a one-week duration (running for five to seven days, depending on how you have set up your preferences). The same principle holds true for monthly print-outs.

**LAYOUT OPTIONS**

The Layout Options dialog box allows you to customize any of the print formats offered. To access it, select a format in the Print dialog box and click **Options**.

You can save your customized format under its own name as a new format that will be included in the list of formats offered in the Print dialog box. For example, if you customize the "Landscape, small" format, you can set up all of your settings for each of the tabs within that format and then save it, either under the same name or as a different format with another name.

When working in the Layout Options dialog box, you can click the buttons at the bottom of the dialog box at any time:

- Click **Save** to save your customized format under its original name.
- Click **Save As...** to save your customized format under a new name. When you’ve done this, you can save any further changes with the **Save** button.
- If at any time you want to change the name of a format, click **Rename**. You will be prompted to enter the new name for the format you are working with.
- Clicking **Reset** will delete the customized settings you have entered and automatically re-enter the default settings for the Portrait format.
- Clicking **Delete** will permanently erase the format you have selected.
- Click **OK** to accept the settings you have chosen. This returns you to the Print dialog box.

**LAYOUT OPTIONS — DAILY AGENDA PAGE**

On the Daily tab of the dialog box, you can select the special features you would like included on your Daily
Agenda pages and the kind of layout to use. The boxes that appear checked are the default selections. You can select one or more of the following options:

- **Start time:** Your Agenda will print the times at which Agenda Entries are scheduled to begin.
- **End time:** Your Agenda will print the times at which Agenda Entries are scheduled to end.
- **Description:** Your Agenda will print any descriptions included in Agenda Entries.
- **Location:** Your Agenda will print the scheduled location for Agenda Entries.
- **Gray shading:** All your Agenda Entries will be shaded in gray, to make your free time more visible.
- **Overflow pages:** An overflow page will be printed for items that could not be fitted on the Daily Agenda page.

You can also select the column headings. These allow you to rearrange the layout of your Daily Agenda page. You can choose where you want each element to be placed on the page, and which elements you wish to include or leave out. You may want to experiment with these, using the Print Preview (see p. 85) to view the results before you print your pages out.

Finally, you can set the time range for which you want to print your Daily Agenda pages. You may want only your working hours included, or you may want to print out your entire day. Use the arrows to the right of the time display boxes, or choose the clock button to set the time.

**Layout Options — Weekly Agenda Page**

On this tab of the dialog box, you can select the special features you would like included on your Weekly Agenda pages. The boxes that appear checked are the default selections. You can select one or more of the following options:

- **Start time:** Your Agenda will print the times at which Agenda Entries are scheduled to begin.
- **End time:** Your Agenda will print the times at which Agenda Entries are scheduled to end.
- **Description:** Your Agenda will print any descriptions included in Agenda Entries.
- **Location:** Your Agenda will print the scheduled location for Agenda Entries.
- **Work days only**: Saturdays and Sundays will not be printed.

- **Gray shading**: Your Agenda Entries will be shaded gray, to make your available time more visible.

- **Overflow pages**: An overflow page will be printed for items that could not be fitted on the Weekly Agenda page.

- **Day Events and Notes**: Your Agenda will print your Day Events, Daily Notes, and Holidays at the bottom of each day.

You can also set the time range on your Weekly Agenda print-outs using the arrows to the right of the time display boxes, or by clicking the clock button to set the time.

**Layout Options — Monthly Agenda Page**

On this tab of the dialog box, you can select the special features you would like included on your Monthly Agenda pages. The boxes that appear checked are the default selections. You can select one or more of the following options:

- **Overflow pages**: An overflow page will be printed for items that could not be fitted on the Monthly Agenda page.

- **Work days only**: Saturdays and Sundays will not be printed.

- **Start time**: Your Agenda will print the times at which Agenda Entries are scheduled to begin.

- **End time**: Your Agenda will print the times at which Agenda Entries are scheduled to end.

**Layout Options — Day Lists**

The Day lists you print include information about the Entries that have been scheduled in your Agenda during a given period. On the Day List tab, you select the special features you would like included on your Day List pages. The boxes that appear checked are the default selections. You can select one or more of the following options:

- **Attendees**: Your Agenda will print the names of Agenda Entry attendees. The maximum value allows you to limit the number of people and resources the print-out will list. If there are more attendees than the set limit, your print-out will only indicate their number.
Description, Task Comment: Your Agenda will print any descriptions of Agenda Entries and Task comments. The maximum value allows you to limit the length of descriptions or comments that your Agenda prints. If the description or comment contains more characters than the set limit, your print-out will only indicate the its length.

Importance level: Your Agenda will include the importance level of Agenda Entries and the priority of Tasks in the Day List.

Owner: Your Agenda will indicate who owns the Entry on the print-out.

Tasks: All Tasks for the selected days will be printed out.

Day Events, Notes, Holidays, Upcoming: Your Agenda will include all Entries that are displayed in the Notes View of your Daily Agenda page on your Day List.

Empty days: Those days without any scheduled Entries will be included in the print-out.

Layout Options — Task Lists

On the Task List tab, you select the special features you would like included when you print your Task Display. The boxes that appear checked are the default selections. You can select one or more of the following:

Task Comments: Your Agenda will print any comments you have included in your Tasks. The maximum value allows you to limit the length of comments that your Agenda will print. If the comment contains more characters than the set limit, your print-out will only indicate the length of it.

Start date: Your Agenda will print the dates on which your Tasks are scheduled to start.

Due date: Your Agenda will print the dates on which your Tasks are due.

Completion date: Your Agenda will print the dates on which your completed Tasks were completed.

Layout Options — Fonts

You can select the fonts that are used in your print-out. The fonts that appear are the default selections.
• Select a header font. The Default font allows the computer to select the closest match to either the Helvetica or Times type faces. You can also set the font size: select either normal, small, or large. The application will use the appropriate size of the selected font for the layout you are using.

• Select a text font. The Default font allows the computer to select the closest match to either the Helvetica or Times type faces. You can also set the font size: select either normal, small, or large. The application will use the appropriate size of the selected font for the layout you are using.

**Layout Options — Margins**

You can select the margins for the pages you print out. The values that appear are the default settings.

• Select measuring unit: Choose either inches or centimeters.

• Set the number of rows and columns: Type in the appropriate value in each box.

• Set the margins and internal margins: Type in the appropriate values in each box.
PRINT PREVIEW

The Print Preview feature allows you to see what your print-outs will look like before you print them.

The buttons above the viewing area let you control your view. Choose to view one page or pairs of pages at a time using the One Page/Two Page button (the label on the button will change, depending on which view you are currently in). You can also zoom in to view details of your pages or zoom out to see the overall look. You can zoom into a view twice, after that Zoom In is dimmed. Conversely, when you have zoomed out to the full page view, Zoom Out is dimmed (as shown in the illustration). You can also zoom in and out using the Magnifying Glass Cursor. Turn the pages you are viewing using Next Page and Previous (Prev.) Page.

When you have finished viewing your document, click Close to return to the Print dialog box.
ALL ABOUT THE MAIL

You can send e-mail messages to others when you reply to their invitations or when you create, edit, or delete Entries to which you have invited other people and resources. However, a mail message is not required to reply to an invitation or to send Entries to others.

You can also let other users send you mail messages notifying you that they are inviting you to new Entries (see Agenda Preferences — Notification, p. 72).

To send an e-mail message about your response to an Entry you’ve received in your In-tray, click the Mail Message button (see left) in the Reply dialog box. This opens the Mail Message dialog box.

Depending on how you have set your Notification Preferences (see p. 72), your Agenda may display a message box asking you whether you want to send an e-mail message each time you create or modify an Entry to which other users have been invited.

- If you want to send an e-mail message, click Yes. The Agenda then opens the Mail Message dialog box for you.

- If you do not want to send an e-mail message, click No. Your Entry will still appear in the Intrays and Agendas of the other users.

You can also set up your mail client preferences to start up your mail application from the toolbar.

MAIL MESSAGE

The Mail Message dialog box opens when you choose to send an e-mail message about an Entry. In this dialog box, you write your message, decide to whom it will be sent, and send it.

Create the list of people to whom you will send your mail message. All the invited people as well as the designates for invited resources are included on the list by default. If your message concerns a new Entry, the users must have set their notification preferences to receive e-mail notifications about new Entries in order to be included on the list.

To add a person to the list, type their name in the “Other:” edit box. If you want to add the users with designate rights for a specific resource, type "r:", "re:", or "res:", followed by the resource’s name. If you want
to add a group, type "g:", "gr:", or "grp:”, followed by the group’s name. Click the Checkmark to accept the addition. This adds the person to the list of users who will receive your message. Clicking the "X" erases the name from the edit box and cancel the addition. To add several users or groups at once, use the Search feature. Click the Search button to open the Directory Search dialog box. (See also, Creating Lists, p. 49 & Searching, p. 55.)

As you add people to the list, they will appear in the Distribution list. To delete a person from the list, select their name in the list box and click Delete. The Send button remains dimmed until at least one person appears on the Distribution list.

Compose your message in the Message to Send edit box. Basic information about the Entry you are replying to will already appear in the edit box. Scroll down to add further information to the message. You can cut and paste text from other applications into your message using the standard Ctrl-C (copy), Ctrl-X (cut) and Ctrl-V (paste) commands. You can also delete any of the information that has been automatically included in your message.

When you have finished writing your message, click Send to send it to all the people on the Distribution list.

**MAIL CLIENT SETTINGS**

To start your mail program from within your Agenda, you need to enter the file path to your mail application in your Agenda. You do this on the Mail Client tab of the General Preferences dialog box (Options Menu, General).

To set up this function, type in the name of the executable file for your e-mail program. This allows your Agenda to find your mail program. You can also click Browse to search for the mail application path. The executable file will be called “name.exe”. Select “Minimize on Start-up” if you do not want the mail program to appear as the top window when you start it up through your Agenda.

Once this is set up, you can start your mail program by choosing Launch Mail Application from the File Menu or by clicking the Launch Mail button on the toolbar (see left).
NOTE:

- This is an optional feature meant for your convenience. It does not have any effect on your Agenda's e-mail notification features, which are entirely independent of the mail client settings you enter here.

- If you wish, you can choose to start up a different program from this button by entering the executable file name for the program you wish to start up instead.
THE OFF-LINE AGENDA

You can access your Agenda both on-line and off-line. After working without a connection to the server, you can easily update your On-line Agenda by uploading your off-line files: your Agenda will help you reconcile any differences. You can set up your Off-line Agenda either by using the Off-line Preferences dialog box (Options Menu, Off-line) while working on-line, or when you sign in Off-line for the first time.

CREATING AN OFF-LINE AGENDA

On the same computer as your On-line Agenda or on a computer hooked up to the same network

Creating your Off-line Agenda is simple. All you need to do is to decide where you want your Off-line Agenda to be stored, and then download your On-line Agenda. Do this either by using the Off-line Preferences dialog box (see Off-line Preferences, p. 68) and the Download to Local File command from the File Menu, or by signing in off-line and using the Off-line Configuration dialog box (see Signing in Off-line, p. 1).

Once you have chosen the location of your Off-line Agenda, you can open it by choosing Off-line as your server option when you sign in (see left). You can also switch between your Off-line and On-line Agenda using the command Work Off-line/On-line from the File Menu.

On a computer not on the network

If you want to locate your Off-line Agenda on a computer that is not part of your network, copy the necessary files to that computer. You must make sure of the following:

- Copy the four necessary files from the directory you selected as your off-line location (see Off-line Location, p. 68):
  - XTMlocal.dat
  - XTMlocal.NDX
  - XTMPARAM.INI
  - XTMTZONE.INI
- the Agenda’s software must be installed on the computer you wish to use.

To reconcile your Agenda, you must return these files to their original location.

NOTE: The XTMlocal.dat and XTMlocal.NDX files can become quite large, depending on the amount of data being transferred to your Off-line Agenda. Should the files become too large to transfer by diskette, a network connection will be necessary.
RECONCILING YOUR AGENDAS

You start uploading your Off-line Agenda file into your On-line Agenda by choosing Upload From Local File from the File Menu. A window will appear on screen to show you the progress. Making the two Agendas consistent with one another is a process called "reconciliation". The Reconciliation dialog box may appear each time an inconsistency is found between the two Agendas during the upload process (depending on your preferences, see p. 70).

The dialog box is divided into four sections. Along the upper edge of the dialog box, information is displayed about the type of Entry that needs to be reconciled (the icon), and that Entry’s status in the Off-line and On-line Agendas. The two list boxes contain the details of the inconsistency. The upper list box shows the Entry as it appears in the Off-line Agenda; the lower list box as it appears in the On-line Agenda. Indicate how you wish to treat the inconsistency at the bottom of the box. The uploading of your Agenda file will then continue.

If Agenda Entries are created or modified both in the On-line and Off-line Agenda, scheduling conflicts can arise between these Entries. When you upload your Off-line Agenda, the Conflicts Detected dialog box appears when such conflicts are detected (depending on your preferences, see p. 70).

The Conflicts Detected dialog box shows you information about the conflicts. At the top of the dialog box, the Off-line Agenda Entry that is causing the conflicts is indicated. The left-hand list box contains all the Agenda Entries in conflict with the Off-line Entry. When you select an Entry in the left-hand list box, all the invited people and resources for whom the selected and the Off-line Entry are in conflict will be listed in the right-hand list box. Decide what to do about the conflicts by clicking one of the following buttons:

- **Ignore conflict**: The Off-line Entry will be added to the Agenda regardless of the conflicts.
- **Reschedule**: Click this button to edit the Entry. Make the necessary changes and click OK.
- **Delete local entry**: The Off-line Entry will not be added to your Host Agenda.

After you have made your choice, the uploading of your Off-line Agenda will continue.
DATA IMPORT & EXPORT

You can transfer data between your Agenda and a Hewlett Packard palmtop computer, or between the Agenda and a number of different data files, including various ASCII format files, Schedule+ files, and vCalendar files.

THE EXPORT UTILITY

The Export Utility dialog box opens when you choose Export Data from the File Menu. It allows you to export information from Agendas into text files or supported palmtops.

Start by selecting the type of palmtop or file to which you are exporting your data. The text file formats available include:

- ASCII Comma Delimited File
- ASCII Tab Delimited File
- ASCII Activity by Date File
- ASCII Activity by Item File
- ASCII Full Activity File
- HP 100LX/200LX Appointment Book file (creates a 100LX/200LX-compatible data file)
- vCalendar file (text file used to transfer calendar data to any application that can paste plain text or the vCalendar registered format to the clipboard).

The palmtop computers that are supported are:

- Hewlett-Packard HP-100LX
- Hewlett-Packard HP-200LX.
Once you have chosen the kind of file or palmtop to which you want to export data, set the period of time for which you wish to export and select the people and resources from whose Agendas you want to include. Type their names one by one in the People/Resources edit box and add them to the list in the list box below (see Creating Lists, p. 49). Your Agenda will export the Entries of all the people and resources listed.

File names are automatically assigned to the files created when you export. If you select the name of a person or a resource in the list box, the corresponding file name is displayed in the edit box below. You can change the names of these files if you wish to. If you are not exporting to a palmtop, you can look for the file on your system by clicking Browse.

If you are exporting your data to a palmtop, select the serial port you are using. Click Link Settings next to the File Name edit box and select one of the options offered in the Serial Settings dialog box that is called up.

Click Export once you have entered all the necessary information. If you are exporting data to a palmtop and there are inconsistencies between the palmtop and your Agenda, you may have to go through a Palmtop Reconciliation process before the conclusion of your data export. If so, the Palmtop Reconciliation dialog box appears.

**THE IMPORT UTILITY**

The Import Utility allows you to import data into your Agenda from certain files and supported palmtops.

When you select Import Data from the File menu, the Import Utility dialog box opens. Select the type of file or palmtop from which you will be importing your

---

**NOTE:** If you export data to a palmtop and this is the first time you export/import with your palmtop, you need to install a link between your Agenda and the palmtop. Open the DataComm application on your palmtop, choose File Receive from the File Menu and enter the file name ul.exe. Then click **Link Settings** in the Export Utility dialog box of your Agenda, and click **Link Install** in the Serial Settings dialog box that appears. You will not need to do this again, unless the batteries on your palmtop run down, erasing all the data and applications it contains. (See also, p. 98.)
data. You can import data from HP-100LX/200LX Appointment Book files, Schedule+ files, or vCalendar files, and from Hewlett-Packard HP-100LX and Hewlett-Packard HP-200LX palmtops.

In the File Name edit box, enter the name of the file from which you are importing. Clicking the arrow to the right of the edit box displays a list of the last files from which you have imported. If you are not importing from a palmtop, you can look for the file on your system by clicking Browse.

If you are importing data from a palmtop, select the serial port you are using. Click Link Settings next to the File Name edit box and select one of the options offered in the Serial Settings dialog box.

NOTE: If you are importing data from your palm-top and this is the first time you export/import with your palmtop, you need to install a link between your Agenda and the palmtop. Open the DataComm application on your palmtop, choose File Receive from the File Menu and enter the file name ul.exe. Then click Link Settings in the Import Utility dialog box of your Agenda, and click Link Install in the Serial Settings dialog box that. You will not need to do this again, unless the batteries on your palmtop run down, erasing all the data and applications it contains. (See also, p. 98.)

Choose the period for which you wish to import data. Then click Import. If you are importing a vCalendar file, a dialog box appears, letting you handle the events being imported either individually or collectively. When importing from a palmtop, the Palmtop Reconciliation dialog box opens to let you deal with inconsistencies between the palmtop and your Agenda.

WORKING WITH vCALENDAR ENTRIES

The Agenda can import and export vCalendar objects from files (vCalendar files have the suffix .vcs). A .vcs file may contain one or several vCalendar objects. This allows you to share events with other users, post events on a Web site, and receive events from other users or Web sites.

There are several ways to import and export vCalendar Entries. You can use the Import and Export Utilities (as described above), you can drag and drop the Entries into or out of your Agenda, or you can copy them via the Clipboard using the cut (Ctrl-X), copy (Ctrl-C), and
paste (Ctrl-V) commands. Any kind of Entry (Agenda Entry, Daily Note, Day Event, Task, or Holiday) can be imported and exported from any view (the Daily, Weekly and Monthly Agenda pages, the In-tray, and the Task Display) in this way. However, Holidays imported in this manner are converted to Day Events, since the right to create Holidays is restricted (see Holidays, p. 44).

vCalendar objects are appearing with increasing frequency on Web sites as a means of informing people about upcoming events. You can import these vCalendar objects to your Agenda using your Netscape browser. All you need to do is double-click the vCalendar object’s icon. If your Agenda is not running at the time, you will be prompted to start it, so that the Entry can be imported. To take advantage of this feature, the vCalendar plug-in must be in the \netscape\programs\plugins directory. The plug-in file for Windows 95 and Windows NT is npvcal32.dll. Windows 3.1 and 3.11 users must use the npvcal16.dll plug-in file.

When you import data from a vCalendar file into your Agenda, a pop-up dialog box appears to let you view the information about individual Entries before you accept or reject them. The type of the Entry currently displayed is indicated by an icon (see right). The total number of vCalendar Entries being imported is displayed along with two scroll buttons. Clicking these buttons will scroll through the Entries being imported. The information available about each Entry is displayed. This information can include the following:

- Title
- Date (Start and Due dates for Tasks)
- Start and End times (Due time for Tasks)
- Access level
- Importance level (Priority for Tasks)
- Location.

To view other details available about the Entry (such as lists of occurrences and attendees), click View Details. The vCalendar Entry Details dialog box appears containing the available details.

To add the Entry currently displayed in the dialog box to your Agenda, click Add Entry. If you do not want to add the Entry to your Agenda, click Reject Entry. If there is more than one Entry, you can add all of them, or the remaining ones, by clicking Add All/Add the
Rest (the latter text appears if you have already handled some of the Entries that were included in the dialog box). Click Close to dismiss the dialog box when you are done.

NOTE: Any Entries that you choose to add to your Agenda in this way are considered to be owned and created by you on your system. You will also be listed as the only attendee. If other people or resources listed as attending will appear on the Details tab, along with any additional information available about the Entry.

PALMTOP SUPPORT

When you export to your HP palmtop, a calendar file is written on the palmtop. Changes made to the palmtop calendar can then be added to your Agenda by importing the data from the palmtop to the Agenda.

A name is automatically generated for the calendar file being created on your palmtop, but you can change the name of the file to suit your needs. Every time you export to the palmtop specifying this file name, any inconsistencies between the file and the Agenda are dealt with in a reconciliation process. In your palmtop reconciliation preferences, you can choose to let the Agenda deal automatically with the details of this process, or you can decide the line of action for each inconsistent Entry on a case-by-case basis (see p. 76). Either way, the palmtop reconciliation ensures that your Agenda and the calendar on your palmtop are identical after the exportation, with consideration to changes made in either one of them (according to your own settings).

You can also import Entries from a calendar file on your palmtop into your Agenda. Your Agenda takes you through a reconciliation process in the same way as described above. In this way, your Agenda and the calendar on your palmtop are also identical after the importation, with consideration to changes made in either one of them (according to your own settings).

Entries that were previously exported from someone else’s Agenda can be imported into yours. Do this by choosing the appropriate palmtop file to import from. However, these Entries will be considered as created and owned by you.

NOTE: Any Entries that you choose to add to your Agenda in this way are considered to be owned and created by you on your system. You will also be listed as the only attendee. If other people or resources listed as attending will appear on the Details tab, along with any additional information available about the Entry.
You should remember that although you can export several Agendas at once, only one palmtop calendar can be imported at one time.

Your Agenda has greater scheduling capabilities than the supported palmtops. As a result, there are some limits on the information that can be transferred. The import and export utilities are intended to help mobile users, but the palmtop cannot serve as a replacement for the Agenda. All types of Entries can be exported, but Agenda Entries exist on your palmtop as Appointments; Day Events, Daily Notes and Holidays exist as Events; and Tasks exist as To-do’s.

Entries that have more than one attendee can be exported to the palmtop. While working on the palmtop, you can edit any aspect of these Entries except the list of people and resources. When importing such Entries into your Agenda, all changes are automatically be updated for every person or resource included in the Entry.

When you export Entries to the palmtop, their Reminders are set by default (they are set to five minutes before the Entry begins).

To exchange data between your Agenda and your palmtop you must perform an initial set-up.

**Installing the UniLink Server**

To exchange data with your palmtop, you will need to install the UniLink Server on your palmtop. This process only needs to be done once, unless you let both the main and auxiliary power supplies of your palmtop run down, in which case you will need to redo this initial set-up.

The following instructions will help you perform the set-up procedure for the HP-100LX and HP-200LX palmtops.

Begin by opening the File Menu in your Agenda and selecting Export Data. Select the Palmtop format and click **Link Settings** at the bottom of the dialog box.

Connect your palmtop to one of the COM ports on your PC using the PC Link cable supplied with your palmtop. Turn on the palmtop and select & to start the Application Manager. Then do the following on the palmtop:
• Press C to start the DataComm Application.

• Press MENU C S to open up the settings dialog box.

• Set the Baud rate to 9600 (press Alt-B and use the arrow keys).

• Set the Interface to Com 1 (press Alt-I and use the arrow keys).

• Set the Parity to None (press Alt-P and scroll through the box).

• Set the Data bits to 8 (press Alt-T and use the arrow keys).

• Set the Stop Bits to 1 (press Alt-S and use the arrow keys).

• Press F10 to confirm these settings.

Then press MENU F P to open up the File Transfer Protocol dialog box. Select the following:

• XMODEM.

• Press F10 to confirm this.

Next press MENU F R to open the Receive File dialog box. Enter C:\UL.EXE in the File name edit box and press F10 to confirm these settings.

In the Serial Settings dialog box of your Agenda, click Link Install. Once the file transfer is complete, exit the DataComm Application of your palmtop by pressing MENU F X. Then go to the DOS Prompt on the palmtop. (Press &...D.) and start the UniLink Server by typing UL.

Finally, if you have not already configured the serial port of your palmtop, you must do so before using your palmtop. No connections can be established if this has not been done. To configure the palmtop, do the following:

• Press &...S to access Setup.

• Press MENU OC to open the Communications Port dialog box.

• Select the “Enable Com1 Port in DOS” option.

• Press F10 to confirm these settings.
**PALMTOP RECONCILIATION**

Palmtop reconciliation is the process of making the palmtop and your Agenda consistent with one another. When you import data from a palmtop (or a HP-100LX/200LX Appointment Book file), the Palmtop Reconciliation dialog box opens to let you start and end the reconciliation process. This dialog box may also appear when you export data and there are inconsistencies between the palmtop and your Agenda.

At the top of the Palmtop Reconciliation dialog box, information about the palmtop file you are importing from (or exporting to) is displayed. If you want to change your Palmtop Reconciliation preferences (see p. 76) before starting the process, you can access them from this dialog box. Click **Options** to open the Palmtop Reconciliation Preferences dialog box.

To start the reconciliation process, click **Start**. Depending on your preferences, the Confirm Entry Deletion, Confirm Entry Modification, and Conflicts Detected dialog boxes may appear during the process. Once the Agenda has finished reconciling (when the Status indicator in the Palmtop Reconciliation dialog box has reached 100%), click **Done** to return to the Import Utility (or Export Utility) dialog box.

The Confirm Entry Deletion dialog box is displayed when your Agenda detects an Entry that has been deleted in the palmtop, but has been left unmodified in your Agenda (if you have set your preferences for that—Options Menu, Palmtop, see p. 76). It gives you all the information about the Entry and lets you decide whether or not to delete the Entry in your Agenda.

At the top of the dialog box, an icon indicates what kind of Entry has been deleted (see right). Information about the Entry is listed in the dialog box. Click **Details** to see any description (comments for Tasks) that has been included with the Entry (then click **Entry Data** to return to the general information about the Entry).

Choose whether to delete the Entry from your Agenda by selecting one of the buttons at the top of the dialog box:

- Select **Remove Entry From Agenda** to delete the Entry in your Agenda.
- Select **Keep Entry in Agenda** to keep the Entry. The Entry will then be re-exported to your Palmtop, so that the latter is identical to your Agenda after the
reconciliation. Thus, this overrides the earlier deletion in your palmtop.

Click OK once you have selected the appropriate button. This returns you to the Palmtop Reconciliation dialog box and the reconciliation process continues.

Depending on your preferences (Options Menu, Palmtop, see p. 76), the Confirm Entry Modification dialog box appears when your Agenda detects an Entry that has been modified both in the palmtop and in your Agenda. It gives you all the information about both versions of the Entry, and lets you decide which one to keep in your Agenda.

At the top of the dialog box, an icon indicates what kind of Entry the dialog box concerns (see right). Below, information about the two versions of the Entry is listed, with double-arrows indicating what has been modified. Click Details to see and compare the versions of any description (comments for Tasks) that has been included with the Entry (then click Entry Data to return to the general information about the Entry).

Choose which version of the Entry you would like to keep in your Agenda by selecting one of the buttons at the top of the dialog box:

- Select Keep Agenda version to keep the version of the Entry that was found in the Agenda. The Entry will then be re-exported to your Palmtop, so that the latter is identical to your Agenda after the reconciliation.

- Select Keep Palmtop version to keep the version of the Entry that was found in the palmtop.

Click OK once you have selected the appropriate button. This returns you to the Palmtop Reconciliation dialog box and the reconciliation process continues.

If Agenda Entries are created or modified both in the palmtop and in the Agenda, scheduling conflicts can arise between these Entries. When you import from your palmtop, the Conflicts Detected dialog box appears when such conflicts are detected (depending on the Palmtop Reconciliation Preferences you have set—Options Menu, Palmtop, see p. 76).

The Conflicts Detected dialog box shows you information about the conflicts. At the top of the dialog box, the palmtop Agenda Entry causing the conflicts is indicated. The left-hand list box contains all the Agenda
Entries in conflict with the palmtop Entry. When you select an Agenda Entry in the left-hand list box, all the invited people and resources for whom the selected and the palmtop Entry are in conflict are listed in the right-hand list box. Decide what to do about the conflicts. Choose one of the following buttons:

- **Ignore conflict**: The palmtop Entry is added to the Agenda regardless of the conflicts.

- **Reschedule**: Click this button to reschedule the palmtop Entry. The Edit Entry dialog box appears. Make the necessary changes and click OK.

- **Delete local entry**: The palmtop Entry is not added to your Agenda and is deleted from your palmtop file.

After you have made your choice, you return to the Palmtop Reconciliation dialog box and the reconciliation process continues.

Once the Agenda has finished the reconciliation process (when all the Entries that need to be reconciled have been dealt with), click Done in the Palmtop Reconciliation dialog box to return to the Import Utility (or Export Utility) dialog box.
# MENU COMMANDS

<table>
<thead>
<tr>
<th>File</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Open Agenda</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Open Tasks</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Open In-tray</strong></td>
<td>Ctrl+I</td>
</tr>
<tr>
<td><strong>Close</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Download To Local File...</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Upload From Local File...</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Work Off-line...</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Launch Mail Application</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Turn Reminders Off</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Export Data...</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Import Data...</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Print...</strong></td>
<td>Ctrl+P</td>
</tr>
<tr>
<td><strong>Print Setup...</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Exit</strong></td>
<td></td>
</tr>
</tbody>
</table>

| An Agenda...  | Ctrl+A  |
| A Group Agenda...  | Ctrl+G  |
| A Group Agenda As Designate...  |   |

| Your Tasks  | Ctrl+T  |
| Modify Other's As Designate...  |   |
| View Other's Tasks...  |   |

### Open Agenda
This lets you open an Agenda. Drag your cursor to the arrow on the right to view the submenu (see below left). Select one of the options.

### Open Tasks
This lets you open a Task Display. Drag your cursor to the arrow on the right to view the submenu (see below left). Select one of the options.

### Open In-tray
Opens the In-tray.

### Close
Closes the active document.

### Change Password
Lets you change your password.

### Download to Local File...
Downloads your On-line Agenda to your Off-line Agenda.

### Upload from Local File...
Uploads your Off-line Agenda to your On-line Agenda.

### Work Off-line/On-line...
Switches from on-line to off-line mode.

### Launch Mail Application
Starts your mail application (if you have one set up.)

### Turn Reminders On/Off
Turns the Pop-up Reminders on or off.

### Export Data...
Exports Agenda data to a palmtop or file.

### Import Data...
Imports data from a palmtop or file.

### Print...
Prints the active document.

### Print Setup...
Changes the printer and printing options.

### Exit
Quits the application.
New Task...  
Opens the New Task dialog box.

Edit Selected Task...  
Opens the Edit Task dialog box.

Print Selected Task...  
Prints the selected Task.

Duplicate Selected Task  
Makes a copy of the selected Task.

Delete Selected Task  
Deletes the selected Task.

Show Tasks  
Choose from the submenu which Tasks should be listed in your Task Display:

- All Tasks displays all existing Tasks.
- Incomplete Tasks displays only incomplete Tasks.
- Completed Tasks displays only Tasks marked as 100% completed.
- Active Tasks displays only those incomplete Tasks whose start date has passed.

Sort Tasks  
Choose from the submenu how the Tasks listed in your Task Display should be sorted:

- by Description sorts the displayed Tasks alphabetically by description.
- by Due Date sorts the displayed Tasks chronologically by due date.
- by Start Date sorts the displayed Tasks chronologically by start date.
- by Priority sorts the displayed Tasks according to their assigned priority.

Refresh All  
Refreshes the information in all windows.
<table>
<thead>
<tr>
<th>Agenda</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Entry...</td>
</tr>
<tr>
<td>New Daily Note...</td>
</tr>
<tr>
<td>New Day Event...</td>
</tr>
<tr>
<td>New Task...</td>
</tr>
<tr>
<td>Open Entry...</td>
</tr>
<tr>
<td>Print Entry...</td>
</tr>
<tr>
<td>Duplicate Entry...</td>
</tr>
<tr>
<td>Reschedule Entry...</td>
</tr>
<tr>
<td>Delete Entry...</td>
</tr>
<tr>
<td>Refresh all</td>
</tr>
</tbody>
</table>

| View Day | F8   |
| View Week | F9   |
| View Month | F10  |

**New Entry...**  
Opens the New Agenda Entry dialog box.

**New Daily Note...**  
Opens the New Daily Note dialog box.

**New Day Event...**  
Opens the New Day Event dialog box.

**New Task...**  
Opens the New Task dialog box.

**Open Entry...**  
Opens the selected Entry.

**Print Entry...**  
Prints the selected Entry.

**Duplicate Entry**  
Makes a copy of the selected Entry.

**Reschedule Entry...**  
Moves the selected Entry to another date.

**Delete Entry...**  
Deletes the selected Entry from the Agenda.

**Refresh All**  
Refreshes the data in all windows.

**View Day**  
Displays the Daily Agenda page.

**View Week**  
Displays the Weekly Agenda page.

**View Month**  
Displays the Monthly Agenda page.
Print Entry…
Prints the selected Entry,

Find Entry
Finds the selected Entry in the Agenda pages.

Delete Entry…
Deletes the selected Entry.

Refresh All
Refreshes the information in all windows.

Cut
Cuts the selected Entry from your Agenda and places it on the Clipboard, so that you can paste it into an editor or an e-mail message.

Copy
Copies the selected Entry from your Agenda to the Clipboard, so that you can paste it into an editor or an e-mail message.

Paste
Pastes the current contents of the Clipboard into your Agenda.

Search Directory…
Look for people or resources in the directory. (This only displays information about the users you find. You cannot access users from here.)

Where is Person…
Find out what a person has scheduled in their Agenda at a specific time (if you have the right to access the pertinent information).

Manage Groups…
Add, modify, or delete groups.

Holidays…
Modify the Holiday list (if you have the authorization to do so.)
### Options

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agenda...</td>
<td>Edit your Agenda preferences.</td>
</tr>
<tr>
<td>In-tray...</td>
<td>Edit your In-tray preferences.</td>
</tr>
<tr>
<td>Scheduling</td>
<td>Edit your Scheduling preferences.</td>
</tr>
<tr>
<td>Entry Defaults...</td>
<td>Edit your Entry Default preferences.</td>
</tr>
<tr>
<td>General...</td>
<td>Edit your General Preferences.</td>
</tr>
<tr>
<td>Off-line...</td>
<td>Edit your Off-line Agenda preferences.</td>
</tr>
<tr>
<td>Palmtop</td>
<td>Edit your Palmtop Reconciliation preferences.</td>
</tr>
<tr>
<td>User Information</td>
<td>Displays the system’s information about you (or the user you have signed in as). If your system allows it, you can also change this information here.</td>
</tr>
<tr>
<td>Change Password...</td>
<td>Lets you change the password for signing in to your Agenda.</td>
</tr>
<tr>
<td>Access Rights...</td>
<td>Set the Access rights other users have in your Agenda.</td>
</tr>
</tbody>
</table>

### View

<table>
<thead>
<tr>
<th>View</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Toolbar</td>
<td>Displays or hides the toolbar.</td>
</tr>
<tr>
<td>Status Bar</td>
<td>Displays or hides the status bar.</td>
</tr>
</tbody>
</table>
Cascade
Arranges the open windows in overlapped pattern.

Tile Horizontally
Arranges the open windows in horizontal non-overlapping tiles.

Tile Vertically
Arranges the open windows in vertical non-overlapping tiles.

Arrange Icons
Arranges the icons of all minimized windows neatly along the bottom of the main window.

Close All
Closes all open windows within the application.

Window 1, 2, etc.
Selecting a window from this list will activate that window.

Contents
Displays the Table of Contents for the On-line help system.

Using Help
Provides general information about using the On-line help system.

About...
Displays information about this version of the software.
INDEX

Access
level: 4, 9, 25, 33, 36-38, 40, 42, 60-62, 74-75
rights: 2, 29, 31, 59, 63, 107

Agenda
Entry Defaults: 74
Menu: 6-10, 12, 16-18, 33, 36-40, 42-43, 105
Pages: 3, 11, 14, 18, 62, 66, 79-82, 84-85
Preferences: 71-72
Alert: xi, xx, xxiii, 23
Associate: xxi, 35-36, 38
Attachment: xxi, 34-36, 38, 43
Change Password: 2, 103, 107
Color
Coding: 65, 71
Scheme: xviii, 66
Communications Port: 99
Confidential: xxi, 60-62
Conflict: 34-35, 71, 92, 101
Context-specific Help: iii
Create
Agenda Entry: 7, 17, 20, 30, 33-35
Task: 9, 26, 36-37, 42-43
Daily Note: 10, 40
Day Event: 10, 38-39
Groups: 51-52
Creator: xxi, 37
CS&T Icons: xi
Daily
Agenda Page: xiii, 6, 9, 11, 22, 80-81
Note Defaults: 75
Notes: xxi, 10, 14, 17, 40, 60-62, 75
DataComm Application: 93, 95, 98-99
Date Control Bar: xix, 6, 11-12, 14-20
Day
Event Defaults: 75
Events: xxi, 10, 14, 17, 38-39, 41, 60-62, 75
List: 79, 82-83
View: 6-8, 11, 19, 71
Default Reminders: 47, 74-75
Delete
Agenda Entry: 8
Daily Note: 10
Day Event: 10
Entry: 8, 10, 18, 24, 105-106
Member: 53
Selected Task: 26, 104
Designate Rights: 29-31, 59-61
Designator Selection: 30
Directory
Menu: 10, 29, 44, 51, 55, 58-59, 106
Search: 55-58
Distribution List: 88
Domain: xxii, 55, 66
Double-clicking: 7-10, 14, 17, 22-23, 26-27, 33, 35-41, 43-44, 72-73, 96
Drag-and-Drop: 17
E-mail: xxii, 23, 29, 72, 87-89, 95, 106
Edit
Agenda Entry: 8, 36-37, 41, 60
Daily Note: 40-41, 60
Day Event: 39, 41, 60
Entry: 3-4, 8, 10, 14, 17, 20, 22, 29, 36-37, 39-41, 43, 60, 92, 98, 101
Selected Task: 26, 43, 104
Task: 9, 25-26, 43, 61, 104
Entry
Creation: 3-4, 14, 20, 29-30, 47, 72, 74, 87, 92, 97
Defaults: 47, 74-75, 107
Deletion: 8, 10, 14, 18, 24, 29, 34, 37, 70, 72, 76, 87, 92, 96, 100-101
Export: 93-95, 97-100, 102-103
File
Menu: 3, 19, 21, 25, 29-30, 69, 79, 89, 91-95, 98, 103
Transfer Protocol: 99
Find Entry: 22, 106
Fonts: 84
Foreign User: xxii, 55-57
Full
Designate Rights: 61
Viewing Rights: 62
Group
Agenda: 1, 3-5, 19-20, 30
Management: 51-52
Selection: 20
Types: xxii, 51, 56
Hewlett-Packard
HP-100LX: 93-94
HP-200LX: 93-94
HP Palmtop: 97
Holiday: 10, 21, 44, 106
Host
Agenda: 70-71, 92
Reconciliation: 92
Import: 76-77, 93-103
Importance level: xxii, 13, 33, 36-37, 65, 71, 74, 83, 96
In-tray: xiv, 21-24
In-tray
Menu: 22, 24, 72, 106
Preferences: 72-73, 107
Invite: 2, 21, 33-34, 38, 60, 63, 72
Key Conventions: xxv
Launch Mail Application: 89, 103
Layout Options: 80-84
Link Install: 93, 95, 99
Linked Task: 36-37, 42
Load Regions: 67
Local
File: 69, 91, 103
Resources Only: 56
User: xxii
Mail
Client Preferences: 88-89
Message: 23, 87-88
Main Window: 108
Make Time Zone Change: 68
Manage Groups: 51, 106
Meeting (see Agenda Entry)
Modify (see Edit)
Month View: 16-18, 33
Monthly Agenda Page: xiv, 16, 33, 82
Moving: 8, 13, 16
Multiple:
  Entry: 41
  User Selection: 55, 57
Name Formats: 66
New
  Agenda Entry: 7, 17, 20, 33-35, 38, 40, 105
  Daily Note: 10, 40, 105
  Day Event: 10, 38-39, 105
  Entries: xiv, xxii, 21, 23, 36, 44, 72
  Entry: 7, 17, 24, 33, 36, 105
  Entry Alert: 23
  Holiday: 44
No
  Designate Rights: 61
  Viewing Rights: 62
Node: xxii, 1
Normal
  Entries: 60
  Hours: 65
  Tasks: 61
Notes View: xv, 6, 10, 12, 14, 38-40, 44
Off-line
  Agenda: 1-2, 68-71, 76, 91-92
  Entry Downloading: 69
  Group Downloading: 69
  Location: 68
  People/Resources Downloading: 69
  Preferences: 68-70, 91
  Reconciliation Preferences: 70
On-line
  Agenda: 69-71, 76, 91-92
  Help: iii, 108
Open
  Agenda: 3, 19, 29-30, 61, 103
  Entry: 8, 17, 36, 39-40, 43, 105
  Group Agenda: 19
  In-tray: 21, 103
  Tasks: 25, 30, 103
Options Menu: 2, 4, 26, 47, 65-68, 71-72, 76, 88, 91-92, 100-101, 107
Organization Unit: xxii, 49-50, 55, 66
Palmtop
  Reconciliation: 76-77, 94-95, 97, 99-102, 107
  Reconciliation Preferences: 76, 97, 99, 101, 107
Personal
  Entries: 60
  Tasks: 61
Pop-Up Reminder: xviii, 47, 74-75
Preferences: 47, 65-74, 76-77, 88, 107
Print
  Entry: 22, 105-106
  Groups: 52
  Members: 52
  Preview: 79, 85
  Selected Task: 104
  Set-Up: 79, 103
Priority: 9, 25-26, 42, 61, 74, 83, 96, 104
Private: 51, 56, 70
Reconciliation: xxiii, 70, 76-77, 92, 94-95, 97, 99-102, 107
Recurring Entries: 21, 40-41, 60
Refresh: xxiii, 72, 104-106
Reminders
  On: 103
  Pop-up: xviii, 47, 103
  Upcoming: 10, 14, 47
Remote User: 55-57, 60
Repeating: 33-34
Reply: 22-24, 37-39, 41, 60, 72-73, 87
Reschedule Entry: 105
Resource: xxiii, 1-3, 30-31, 50, 56, 66, 88
Same as Default: 59
Scheduling
  Conflicts: 35, 70-71, 76-77, 92, 101
  Preferences: 65, 107
  Rights: 59, 63
Scroll: 11, 15, 17, 88, 96, 98
Search
  Directory: 55, 58, 106
  Parameter: xxiii, 1, 55-56, 58
Searching: 55, 57
Serial Settings: 93-95, 99
Server: xxiii, 1-2, 55, 91, 98-99
Sign-In: 1-2, 91
Single User Selection: 55-56
Special Cursors: xvi
Status Bar: xx, xxiii, 7-8, 13-14, 24, 107
Task
  Comments: 82-83
  Defaults: 74
  Display: xvi, 25-27, 30, 36-37, 42-43, 62, 72, 79, 95
  Due Reminder: 74
  List: 83
  Start Reminder: 74
View: xvi, 6, 9-10, 25, 36-37, 42-43
Tasks Menu: 26, 42-43, 72, 104
Time
  Control: 44
  Formats: 67, 71
  Selection: 44
  Slot: xxiv, 7-8, 11, 13-14, 33, 71
  Zone: 2, 67-68
Toolbar: xviii, xxiv, 107
UniLink Server: 98-99
Upcoming
  Agenda Entry: 10, 14
  Daily Note: 14, 47
  Day Event: 10, 14, 47
  Holiday: 10, 14, 47
  Note: 10, 47, 74
  Reminder: 10
  Task: 47
Update: 70
Upload: 70-71, 76, 91-92, 103
User Information: 55, 107
vCalendar
  Entries: 95-96
  Format: 106
  Objects: 95-96, 106
View
  Agenda Entry: 37
  Daily Note: 40
  Day: 6